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Foreword

Take a moment to think about the learning styles of your students, as individual as 
their fingerprints. Years of conclusive brain research confirm that each learner’s profile 
of learning strengths and challenges is different. Imagine a learning tool that could 
use students’ learning strengths, provide scaffolds for their learning weaknesses, and 
actually build their learning capacity over time. Apple has made that tool a reality for 
today’s learners. 

Apple provides innovative technologies that conform to students’ unique learning 
profiles and that help them learn efficiently and effectively. Such tools are included with 
Mac computers, iPad, iPod, and iPhone, continuing Apple’s commitment to providing 
tools to empower the individual and make technology accessible for everyone. 

Mac OS X (the Mac operating system) was designed with all users in mind, including 
those with special needs, and offers a rich set of built-in accessibility features that 
can be customized for each student. This means that the same hardware can serve 
everyone in the classroom no matter how diverse their needs.

When all students in a classroom are given the same materials, assignments, and tests, 
some students are able to excel (but may not be close to being really challenged), 
some students may complete the work but fail to find any useful connections to their 
own lives, and some students may fail, not because they are incapable or because 
they don’t try, but because their brains process information differently. The accessibility 
features built into Mac OS X, the powerful suite of applications included on the Mac, 
and features of iPad, iPod, and iPhone allow students to experience the power and 
freedom to access the curriculum, collaborate with peers, and express their unique 
understanding with the digital tools that best meet their needs.

At its simplest, a “universal design for learning” provides a wider variety of options for 
learning, just as “universal design for architecture” provides options for more people 
to cross the street without the obstacles of curbs or enter buildings without using 
stairs or opening heavy doors. Our experience with universal design for architecture 
(initially created to assist people with physical disabilities) was to open up a world of 
convenience and ease for all of us. 

Technology tools hold the same promise for engagement and success in learning 
environments. This Getting Started Guide is designed to help you customize learning 
experiences so that each student gets just the right amount of support based on his or 
her needs. 

You can use this Getting Started Guide to experience the universal design for learning 
features, applications, and tools built into the Mac, iPad, and iPod touch to help you 
create a classroom where every student can select the tools to best support his or her 
learning profile. 
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You’ll learn how to set up and personalize a Mac, an iPad, and an iPod touch—for 
yourself and the learners in your world. You’ll develop an appreciation for the built-in 
software applications that open doors to the world of learning and reduce barriers to 
achievement. You’ll also explore options for engaging students in hands-on learning 
projects with the iLife suite of digital media tools. These tools help students create their 
own understanding of concepts through creative digital projects—movies, music, photo 
books, podcasts, web pages, and more. You’ll read profiles of different types of students 
who use Apple products to address their learning needs in the same classroom—
without being labeled or singled out as “different.” Just as everyone can see the benefits 
of a curbcut to get around, you’ll be able to see the benefit of universal design for 
learning—the Apple way! 

Mary Male, Ph.D.  
Professor Emerita, Special Education  
San Jose State University, California 

Note: This document is based on the features of Mac OS X Snow Leopard. If you are 
using an earlier version of Mac OS X, some options may differ from those described here.
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Setting Up and Personalizing a 
Mac for Diverse Learner Needs 
Apple’s operating system, Mac OS X, provides a uniquely 
accessible experience that enables all students to use and 
share the same technology regardless of language or abilities.

Each Mac is designed to provide students with multiple and flexible ways to access 
content for learning, allowing each student to use their unique learning style. Mac OS X 
features, such as VoiceOver, text-to-speech synthesis, and keyboard navigation options, 
are known collectively as Universal Access. They are designed to work in combination 
to provide smooth, elegant access for students with learning differences. On a Mac, 
these features are built in, easy to locate, and can be adapted to meet each user’s 
requirements. This chapter explains these tools and how you can get started using 
them to address varied students’ needs. The Universal Access features are located in 
System Preferences. 

To set Universal Access and other preferences: 

1	 Choose Apple menu > System Preferences (or click the System Preferences icon in  
the Dock). 

2	 Click the icon for the preference you want to change. 

Setting Up Individual User Accounts on a Computer 
With Mac OS X, you can create individual user accounts with unique preferences to 
support diverse learner needs. Because Mac OS X supports multiple users, each user 
can save his or her preferred settings without affecting other users. 

To create a new user: 

1	 Open System Preferences, then click Accounts. 

2	 If some settings are dimmed, click the lock icon and type an administrator name and 
password. 

3	 Click the Add (+) button and follow the onscreen help information. 

The Parental Controls options allow you to restrict students’ full access to the hard disk 
and Mac OS X applications. You can set these options by clicking Parental Controls in 
System Preferences or by clicking Accounts in System Preferences and then selecting 
the name of the user. 
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With Parental Controls, you can help keep students on task and prevent them from 
accidentally or purposefully modifying their environment. Features that can be 
managed using Parental Controls include: 

•	 Changing preferences settings 

•	 Removing items from the Dock 

•	 Changing passwords 

•	 Using certain installed applications 

•	 Visiting unauthorized websites 

•	 Receiving email from or chatting with unspecified users 

•	 Accessing the computer during specified hours or for a specific amount of time

The System pane in Parental Controls allows you to designate the Simple Finder setup 
for a user. When you set up Simple Finder, students will have a simplified view of the 
desktop, with limited menus and commands in the menu bar and three folders in the 
Dock: My Applications, Documents, and Shared. With Simple Finder, users cannot create 
new folders or add icons to the Dock. You may want to use the Simple Finder setup for 
beginning computer users or users with varying cognitive abilities. 

To set up Simple Finder for a user: 

1	 In the Accounts pane of System Preferences, click the user name, then select Enable 
Parental Controls. 

2	 Click Open Parental Controls, then click System if the System pane is not already 
displayed.

3	 In the System pane, select Use Simple Finder. 

4	 Select the applications and utilities that you want the user to be able to access. 

To enable users to quickly switch between users on the same computer, you’ll want to 
turn on the “fast user switching” option in the Accounts pane of System Preferences. 

To turn on fast user switching: 

1	 In the Accounts pane of System Preferences, click the user name, then click Login 
Options. 

2	 Select the “Show fast user switching menu as” option. Choose Name, Short Name, or 
Icon from the “View as” pop-up menu.

A new menu appears on the right of the menu bar at the top of the desktop that 
allows individuals to quickly and easily switch between accounts. Depending on the 
settings you selected for each user, some users may need to enter a password before 
logging in, while others will see a Simple Finder. Each user’s desktop will reflect the 
individual preferences you’ve specified for that user. 

Once a student account is set up, you can help students organize their files and folders 
in the way that works best for them, taking advantage of the flexibility offered by Mac 
OS X. For example, files can be displayed as icons or in lists and can be stored in folders 
within folders for different subjects or projects, all within the user’s Documents folder. 
If students lose track of a file, they can use the Spotlight feature, the Mac OS X search 
technology, to find it right away. 
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Customizing Settings for Literacy and Learning Needs 
Struggling readers and writers who have specific needs in areas of literacy can use 
technologies included in Mac OS X to address their particular learning challenges. 
These technologies include: 

•	 Text-to-speech synthesis: For hearing the contents of web pages and other documents 
read aloud 

•	 Display Adjustment: For switching the display to white text on a black background to 
enhance readability 

•	 Services command: For creating sticky notes, summarizing text, and finding tools that 
support the writing process

•	 Spaces: For organizing applications and documents into separate areas for each subject

Hearing the Computer Speak Selected Text 

For students who have trouble reading text, you can set up Speech preferences to have 
the computer read aloud the selected (highlighted) text on the screen. Text-to-speech 
gives students auditory input as well as visual input of the text they see on the screen. 

Once a key combination is set up in Speech preferences, students can highlight text 
and press the key combination to hear the text spoken. They can have the computer 
speak the text in many different types of documents, including email messages and 
web pages, and can customize the rate at which content is read aloud. 

To hear the computer speak selected text: 

1	 In System Preferences, click Speech, then click “Text to Speech.”

2	 Select the “Speak selected text when the key is pressed” checkbox. 

3	 Click Set Key.
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4	 Hold down one of the modifier keys (Command, Shift, Option, or Control) and press 
another key to set the key combination you want to use to hear selected text. 

5	 Click OK. 

6	 To change the rate at which the content is read aloud, move the Speaking Rate slider.

7	 Close the Speech pane.

8	 To hear selected text read aloud, press the key combination. 

You can also select text you want spoken and then Control-click anywhere in the text 
to display a shortcut menu. From the shortcut menu, choose Speech, then choose Start 
Speaking. 

Adjusting Display Options 

If students have difficulty visually identifying letters and words displayed on a computer 
screen, you can enhance the contrast or invert the colors displayed on the screen, 
making white and light colors dark and dark colors light. These changes take effect in 
all applications. Some students find it easier to read white text on a dark background 
than black text on a white background. 

To enhance screen contrast: 

1	 In System Preferences, click Universal Access, then click Seeing. 

2	 To remove colors from the screen, click “Use grayscale.” 

3	 To make the computer screen appear as photonegative (with white text on a black 
background), click “White on Black.”

4	 Drag the “Enhance contrast” slider to the right to increase the contrast. 

5	 Close the Universal Access pane.

Getting Note-Taking Support and More with the Services Command  

Students who need extra support with reading, note-taking, and writing, and who have 
other learning needs may want to take advantage of the many different options offered 
through the Services command. This command is available in Safari, TextEdit, Mail, 
Pages, and many other applications. When the Finder is active, the Services command 
is accessed from the Finder menu; when an application such as Mail is open, it’s in the 
menu with the name of the application, in this case, the Mail menu. 

The Services command options include: 

•	 Make New Sticky Note: Students can create Stickies to add to their desktops or 
documents and can type text directly in the note or copy and paste text from another 
document or a web page. 

•	 New TextEdit Window Containing Selection: Students can highlight text they want 
to keep from a web page or another document and readily save it in a new TextEdit 
document. 

•	 Summarize: Students can highlight a segment of text and have the computer create 
a summary of the content, letting them customize the level of detail they want from 
each paragraph. This feature can help students identify the key point in a paragraph, 
clarify the notes they’ve taken, or review what they’ve read. 
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•	 “Look Up in Dictionary”: Students can highlight a word and use this command to 
quickly open a Dictionary window with that entry. Access to the Dictionary, Thesaurus, 
and Wikipedia are all directly built into the OS so all three work in all applications that 
utilize the Mac OS X speech engine.

Services commands can be customized in the Keyboard Shortcuts pane of System 
Preferences. If you don’t see a command listed in the Services menu, you may need to 
add it to the list by selecting it in this pane.￼

To create a sticky note: 

1	 Select the text where you want to create a sticky note.

2	 Choose [Application Name] Services > Make New Sticky Note. 

3	 Type whatever text you want in the sticky note that appears on the desktop. 

Note: In Mac OS X Snow Leopard, you need to select some text before the Sticky Note 
feature becomes available. The note remains on the desktop or the document until you 
click the note’s close button to close and discard it. 

To save text from a document or a web page in a new TextEdit document: 

1	 Open the application that has the text. 

2	 Select the text that you want to keep for notes. 

3	 Choose [Application Name] > Services > New TextEdit Window Containing Selection. 

A new TextEdit document opens with the selected text. 

To create a summary of text: 

1	 Open the file or web page that has the text you want to summarize. 

2	 Select the text you want to summarize. 

3	 Choose [Application Name] > Services > Summarize. 

The Summary window opens with a summary of the text. 

4	 Use the Summarize Size slider to condense or expand the summary. 
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To quickly look up the definition of a word: 

1	 Open the document or web page that has the word you want to look up. 

2	 Select the word you want to learn about. 

3	 Choose [Application Name] > Services > “Look Up in Dictionary.”

You can also display the entry by selecting and then Control-clicking the word (or 
right-clicking using a Mighty Mouse), choosing Writing Tools, then choosing “Look Up 
in Dictionary” from the shortcut menu. 

Learn More About the Services Command 

n	 In the Finder, choose Help > Mac Help, then select the feature you’d like to know more 
about, such as Stickies. 

Organizing Applications and Documents 

To improve productivity and keep students focused, you can separate applications and 
documents into virtual areas (such as by class subject). Spaces allows you to group your 
application windows so that only the ones included in that space are visible to the user, 
yet you can switch between spaces with just a click or a press of a key.

Setting Up Spaces

1	 Click the Spaces icon in the Dock.

When you see the message “Spaces is not set up. Would you like to set it up?”, click Set 
Up Spaces. 

Exposé & Spaces preferences opens.

Tip: You can also choose System Preferences from the Apple menu and click the 
Exposé & Spaces icon. Either way, the Exposé & Spaces preferences window appears.

2	 Click the Spaces button.

3	 Select the Enable Spaces checkbox.

If you want Spaces to be displayed in the menu bar, select the “Show Spaces in menu 
bar” checkbox.

You can add up to four rows and four columns for Spaces by clicking the Add (+) 
button.

Assigning Applications to Specific Spaces

The following steps take you through the process for setting up four spaces: one space 
for iChat, one for Mail, another for web browsing with Safari, and an unassigned space 
that you can designate later.

1	 In System Preferences, choose the number of spaces you want.

The four spaces can be laid out as two rows of two columns or one row of four 
columns. You use the Rows Add (+) or Delete (-) button and the Columns Add (+) or 
Delete (-) button in Spaces preferences until you have the layout you want in the black 
layout area. Here you’ll use one row of four columns.

2	 Click the Columns Add (+) button twice.
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3	 In the Application Assignments area in the middle of the pane, click the Add (+) button. 
Select iChat and click Add. 

iChat now appears in the Application Assignments list. 

4	 To assign iChat to the second space, click the arrows at the right of the list to open the 
pop-up menu and choose Space 2.

With this setup, whenever iChat opens, it automatically opens in Space 2.

5	 Use the same process to add the Mail and Safari applications to the Application 
Assignments list and to set them to use Spaces 3 and 4.

Changing Shortcut Keys

You can change the shortcut key combinations used to switch between spaces by 
making choices from the pop-up menus at the bottom of the Spaces preferences pane. 
The menus are “To activate Spaces,” “To switch between spaces,” and “To switch directly 
to a space.”

You can set any key combination to move to the next space in your specified order, 
from Space 1 to Space 2, from 2 to 3, and so on. You can also disable any shortcut by 
choosing Minus sign (-) from the pop-up menu.

Using Spaces

Once Spaces is set up, you can easily move from space to space. 

To move between spaces:

n	 Display Spaces by pressing F8 (or your assigned “To activate Spaces” key) or by clicking 
Spaces in the Dock, then do any of the following:

•	 Click any space shown to jump directly to that space. You can also drag any window 
you see in any space to any other space.

•	 Press Control-1 to jump to your first space, Control-2 to jump to your second, and so 
on (unless you reassigned these shortcut keys, in which case use your assigned key 
combination).

•	 If you’ve selected “Show Spaces in menu bar” in Spaces preferences, you can click 
the Spaces icon in the upper-right of the menu bar and choose any numbered space 
from the menu.

•	 Use the Control key and the Left Arrow and Right Arrow keys to move forward or 
backward through your spaces (unless you reassigned these shortcut keys, in which 
case use your assigned key combination).

Customizing Settings for Multiple Languages 
With Mac OS X Snow Leopard, you can change the language shown in menus and 
dialogs and see dates, times, and numbers displayed according to the conventions of a 
geographic region. You can also type in a language that uses a different writing system 
(or script) than English without the need for a keyboard designed for that language. 
With multiple languages being represented in so many classrooms, it’s helpful to be 
able to configure the onscreen display and keyboard to work with whatever language 
is needed. 
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Displaying Languages Other than English on the Computer 

You use Language preferences to change the language shown in menus and dialogs 
and to see dates, times, and numbers for a particular region. Students can also view 
multilingual text documents on the computers. Applications that support Unicode, a 
worldwide standard for encoding multilingual text, can display any language. Some 
applications may not support all languages, and in this case there may be missing or 
strange characters in the text. If students have trouble viewing multilingual text, they 
should open the document using a Unicode application, such as TextEdit. 

Mac OS X supports 18 languages. This means you don’t have to purchase separate 
copies of the operating system for multilingual students. The following languages are 
included:

•	 English	 •	 Italian	 •	 Finnish	 •	 Brazilian Portuguese
•	 Dutch	 •	 Japanese 	 •	 French	 •	 Traditional Chinese
•	 Swedish 	 •	 German	 •	 Norwegian	 •	 Simplified Chinese
•	 Spanish	 •	 Danish	 •	 Korean	 •	 Russian
•	 Polish	 •	 Portuguese (Portugal)  

To change the language displayed on the computer: 

1	 In System Preferences, click Language & Text, then click Language. 
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2	 Drag the language you want to see in menus, windows, and dialogs to the top of the 
list. Changes take effect in the Finder the next time you log in and in applications the 
next time they’re opened. 

3	 Click the Formats button in the Language & Text preferences pane to change the 
calendar type or the region used for the time, number formatting, and other elements. 

Customizing Keyboard Layouts for Multiple Languages 

The keyboard layout determines what characters appear onscreen when a key is 
pressed on the keyboard. Using Language & Text preferences in Mac OS X Snow 
Leopard, you can set up a computer so that students can choose to use the keyboard 
for a language other than English. To allow students to use a different keyboard, select 
its layout in the Input Sources pane of Language & Text preferences. Then, when a 
student wants to use that keyboard, he or she chooses it from the input menu that’s 
displayed on the right side of the menu bar. Students can also choose the Keyboard 
Viewer from the input menu to see the location of the characters on the keyboard. 

To adjust keyboard layouts: 

1	 In System Preferences, click Language & Text, then click Input Sources. 

2	 Select the checkbox next to Keyboard & Character Viewer. 

3	 Select the checkbox next to the keyboard layout or layouts you want students to be 
able to use. (You’ll need to scroll to locate most of the layouts.) 

4	 Select the “Show input menu in menu bar” checkbox. 

5	 Click the input menu icon (the flag) in the upper-right corner of the menu bar on the 
desktop. 

6	 Choose the keyboard layout from the menu and start typing. 

7	 Choose Show Keyboard Viewer from the input menu to see the location of the 
characters on the keyboard. 

Customizing Settings for Visual Needs 
Whether they are researching, using the Internet, reviewing notes, or creating 
presentations, blind or low-vision students will appreciate the power of Universal 
Access features in Mac OS X. This section describes some of these technologies: 

•	 VoiceOver: For hearing descriptions of onscreen elements and documents with support 
for over 40 braille displays and eight languages with add-on voice synthesizers

•	 Zoom: For magnifying the screen up to 40x

•	 Cursor Scaling: For increasing the size of the onscreen pointer 

•	 View Options: For changing the way files, folders, and other elements are displayed 

•	 Display Adjustment: For changing contrast, colors, and screen resolution

•	 Keyboard Shortcuts: For controlling the computer with keyboard shortcuts 

•	 Speech Recognition: For controlling the computer through voice 
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Promoting Collaboration with VoiceOver 

VoiceOver is a fully integrated, built-in screen reader technology that provides access 
to the Mac through speech, audible cues, and keyboard or gesture-based navigation. 
It includes an advanced synthesized English voice, braille support, extensive keyboard 
capabilities, and gesture controls using the Multi-Touch trackpad. Also, VoiceOver 
can be used with eight languages—English, Spanish, French, German, Italian, Dutch, 
Japanese, and Chinese. Mac OS X provides an accessible experience for students 
who need to hear descriptions of all the activities taking place on the computer 
and for those who use refreshable Braille displays. VoiceOver also has a new feature 
called braille mirroring that enables multiple braille displays to be connected to one 
computer simultaneously—perfect for classroom settings.

For students who want activities spoken to them, an advanced synthesized voice called 
Alex delivers natural breathing and intonation, even at fast speaking rates. VoiceOver 
also reads aloud the contents of files, including web pages, email messages, and word-
processing files. 

With VoiceOver, students use the keyboard or the Multi-Touch trackpad instead of the 
mouse to navigate the computer’s onscreen elements, such as the Dock, menus, and 
window toolbars. A Caption panel with white text on a black background displays the 
text of what is being read aloud. The braille panel shows a visual representation of 
VoiceOver Braille output along with an English text translation. 

Low-sighted students might want to take advantage of the ability to dim all objects 
onscreen except for the Caption panel and the pointer, called the VoiceOver cursor. 
VoiceOver includes a spoken menu, also displayed with onscreen text, that provides 
information about the available commands. VoiceOver, with its combination of speech, 
onscreen text, and braille support is designed to promote collaboration among 
students—nonsighted students can work side by side with sighted students with no 
artificial barriers. 

If you have a keyboard with a numeric keypad, you can use the NumPad Commander 
to control VoiceOver. 
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To get started with VoiceOver: 

1 Press	Command-F5	to	turn	VoiceOver	on.	Choose	to	view	the	VoiceOver	tutorial	or	
press	the	V	key	to	begin	using	VoiceOver	immediately.

2 Press	Control-Option-H	to	have	the	VoiceOver	menu	appear	in	the	middle	of	the	screen.	
Use	the	arrow	keys	to	navigate	up	and	down	in	the	menu.	Nonsighted	users	can	
navigate the computer elements by hearing the options read to them from the menu 
and	then	making	selections.	Press	Return	to	select	a	menu	item	or	Escape	to	close	the	
menu	without	choosing	an	item.	

The	last	menu	item	is	the	VoiceOver	Getting	Started	Guide.	This	comprehensive	tutorial	
will familiarize you with all of the features of VoiceOver, including how to control 
VoiceOver	with	gestures	and	keyboard	commands.

3 Press	Command-F5	again	to	turn	off	VoiceOver.	VoiceOver	can	also	be	turned	on	and	off	
from	within	the	Seeing	pane	in	the	Universal	Access	preferences	in	System	Preferences.	

To customize VoiceOver settings: 

1 In	System	Preferences,	click	Universal	Access,	then	click	Seeing.	

2 Click	Open	VoiceOver	Utility.	

3 Make selections for Verbosity, Speech, Navigation, Web, Sound, Visuals (to display or 
hide the Caption and Braille panels and the cursor), Commanders (to control VoiceOver 
with	the	Trackpad,	Numpad,	or	Keyboard),	and	Braille	(settings	for	braille	display).	

Settings	can	also	be	changed	by	pressing	Control-Option-F8.	

To use the Multi-Touch trackpad to control VoiceOver:

1 Open	VoiceOver	Utility	and	select	Commanders	in	the	category	table.

2 In	the	Trackpad	pane,	select	Enable	Trackpad	Commander	checkbox.	

3 Begin	interacting	with	the	Multi-Touch	trackpad.
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When you touch the trackpad, it’s as if you’re touching a portion of the screen, so you 
can touch to hear the item under your finger, drag to hear items continuously as you 
move your finger, and flick with one finger to move to the next or previous item. You’ll 
hear how items are arranged on the screen, and you can jump directly to an item just 
by touching the corresponding location on the trackpad. The more you touch, the more 
information you gather.

To use your numeric keypad to control VoiceOver: 

1	 Open VoiceOver Utility and select Commanders in the category table. 

The NumPad pane shows the commands you can use with the numeric keypad.

2	 Select the Enable NumPad Commander checkbox. 

3	 Press the corresponding key on the numeric keypad to issue any of the commands 
listed in VoiceOver Utility.

The NumPad can be customized for each user. Each key on the keypad can be 
programmed with a different VoiceOver command so that each command is available 
with a single keystroke.

To use VoiceOver with a braille display: 

n	 If you have a braille display that VoiceOver supports, simply connect it to your Mac and 
turn on VoiceOver.

Your display is detected immediately and begins to display output.

Using a USB hub, you can attach more than one braille display to a single computer. All 
displays will receive that same output controlled by that central computer.
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To carry VoiceOver preferences from one computer to another: 

1	 Open VoiceOver Utility and select General in the category table. 

2	 Insert a USB flash drive and click the Portable Preferences button to turn it on.  

3	 Select a drive from the list of removable drives and click OK.

VoiceOver detects the portable preferences drive and asks if you want to use it. When 
you use the drive, any changes you make to VoiceOver preferences until you eject the 
drive are automatically saved to the drive. 

When you’re done, eject the portable preferences drive using the Finder or click Stop in 
the General category table in VoiceOver Utility. 

Magnifying the Computer Screen 

You and your students will appreciate the power of Mac OS X Zoom. With Zoom, you 
can make the image on the computer screen larger so that onscreen elements are 
easier to see and read. Magnified, the screen moves continuously and automatically to 
follow the motion of the onscreen pointer. 

You may want to use Zoom for your presentations or instructions to zero in on key 
points and to address the needs of students with low vision. Zoom may also help some 
learners who have difficulty focusing in on a part of the screen when many other items 
are on the screen at the same time. 

To use Zoom: 

1	 Press Command-Option-8 to turn Zoom on or off. 

2	 Press Command-Option-Equal Sign (=) to make the screen image appear larger  
(zoom in). Press Command-Option-Hyphen (-) to make it appear smaller (zoom out). 

You can also use Zoom by holding down the Control key while dragging with two 
fingers on a trackpad or by scrolling the mouse ball on a Mighty Mouse while holding 
down the Control key. 

Zoom can also be turned on and off from within the Seeing pane in the Universal 
Access preferences in System Preferences. 

Scaling the Cursor 

If students have difficulty seeing or following the onscreen cursor, you can increase 
its size so it’s easier to find and follow when they move the mouse. You do this by 
setting Mouse or Mouse & Trackpad options in the Universal Access pane of System 
Preferences. 

To use the scalable cursor: 

1	 In System Preferences, click Universal Access, then click Mouse or Mouse & Trackpad. 
(The exact name varies depending on whether you are using a desktop or notebook 
computer.) 

2	 Drag the Cursor Size slider to adjust the cursor size. 
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Adjusting View Options 

You can change the way applications, folders, documents, and other items appear in 
Finder windows. For example, you can choose to have students view items in a Finder 
window as icons, in a list, in columns, or in Cover Flow. You can also change the size of 
the icons and the icon text. You can magnify the icons in the Dock. 

With these options, you can help students organize the files on the computer in a way 
that works best for them. For example, they can use the Cover Flow view to display the 
first page of every document instead of a list of filenames. They can then use Quick 
Look to speedily view the contents of files without needing to open them first.

To change the way icons appear on the desktop: 

1	 Click the desktop (the background on the screen). 

2	 Choose View > Show View Options, then make selections, such as to make icons larger 
or to increase the size of their text labels. 

To magnify the icons in the Dock: 

n	 Choose Apple menu > Dock > Turn Magnification On. 

Adjusting Display Options 

If students have difficulty seeing objects on the computer screen, you can adjust the 
resolution of the screen to show images larger or smaller. You can also choose different 
screen contrasts to make the screen easier to view for them. You can invert the colors 
displayed on the screen, making white and light colors dark and dark colors light. Some 
students find it easier to read white text on a dark background than black text on a 
white background. With these options, you can set up the computer’s display in the 
way that works best for individual students. 

To adjust the resolution of the screen: 

n	 In System Preferences, click Displays, then select a new resolution from the Resolutions 
list. 

To enhance screen contrast: 

1	 In System Preferences, click Universal Access, then click Seeing. 

2	 To remove colors from the screen, select “Use grayscale.” 

3	 To make the computer screen appear as photonegative (with white text on a black 
background), select “White on Black.”

4	 Drag the “Enhance contrast” slider to the right to increase the contrast. 
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Navigating with Keyboard Shortcuts 

In addition to the keyboard navigation available with VoiceOver, Mac OS X allows you to 
turn on and off and change keyboard shortcuts to access the menu bar, Dock, and other 
areas on the screen. Students can also quickly switch between open applications by 
using the Command and Tab keys. These features can help blind or low-vision students. 

To change one or more keyboard shortcuts for a user: 

1	 In System Preferences, click Keyboard, then click Keyboard Shortcuts. 

2	 Select the action in the Description list that you want to change. You may need to click 
the disclosure arrow to the left of a category to see all of the options. 

3	 Double-click the characters in the Shortcut column and press the key combination that 
you want to use instead. 

4	 Quit and restart any applications you’re using for the new keyboard shortcut to take 
effect. 

To move between open applications: 

1	 Hold down the Command key, then press and release the Tab key. Large icons for all 
open applications appear in the middle of the screen as long as you keep holding down 
the Command key. The icon for the active application is at the far left. 

2	 Press and release the Tab key to move through the applications. 

3	 Release both keys to switch to a selected application. 

Using Spoken Commands to Control the Computer 

Students can use their voice to control the computer and applications by using the Mac 
OS X built-in speech recognition technology, which is another way to assist students 
who have difficulty reading text on the screen. They can speak certain phrases, or 
“spoken commands,” to make the computer take different actions, such as opening 
documents or switching applications. This speech recognition feature is designed to 
work with the built-in microphones in Apple’s computers such as the MacBook, iMac, 
and MacBook Pro. 

To use speech recognition to control the computer: 

1	 In System Preferences, click Speech, then click Speech Recognition. 

2	 Click the Calibrate button to adapt Speech Recognition to your environment. (You 
should do this whenever you move that computer to a new location, such as to a new 
room or outside.) 

3	 Speak each of the phrases listed until each command blinks, signifying that it’s recognized. 

4	 Click Done. 

5	 Click the On button next to Speakable Items. 

The speech feedback window appears on the desktop and shows the “listening key” 
that you need to press before speaking any commands. The default listening key is the 
Escape key. You can change the listening key by clicking Change Key. 

6	 Press the listening key and say your command in a calm voice. 

You can view a list of usable speech commands by pressing the listening key and saying 
“Show speech commands window.”
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Customizing Settings for the Deaf and Hard-of-Hearing 
For students who have difficulty hearing computer sounds and alerts, Mac OS X has 
technologies to assist teaching and learning. These solutions will assist students if 
they need sound amplification or sound output alternatives. Onscreen volume control 
for the built-in speaker gives them control over what they hear. Using individual 
headphones will reduce the noise level in a classroom and give students control over 
the volume. ￼

This section discusses three of the Mac technologies that can aid students with hearing 
impairments: 

•	 Universal Access Hearing preferences: These can be used to set up the screen to flash 
when an alert appears instead of a sound being played. 

•	 QuickTime closed captioning support: Movies with closed captioning can be viewed in 
QuickTime. 

•	 VoiceOver: When speech is muted, VoiceOver can be used as a captioning device for 
VoiceOver-compatible applications.

Students can also use the iMac and MacBook built-in iSight camera with iChat software 
to communicate via text or with video conferences in sign language. (For information 
about using iChat, see “Communicating and Collaborating with iChat,” later in this 
guide.) 

Changing Alert Sounds into Screen Flashes 

If students have trouble hearing the computer’s alert sounds, or if they want to use a 
computer with the sound muted, they can set the computer screen to flash instead of 
playing a sound when an alert is displayed. 



22 Getting Started: 
Apple Technology for Diverse Learners

To use Flash Screen: 

1	 In System Preferences, click Universal Access, then click Hearing. 

2	 Select the “Flash the screen when an alert sound occurs” checkbox. 

3	 Click the Flash Screen button to see what the flash looks like. 

You can also use the Hearing preferences pane to adjust the computer’s volume. 

Viewing Captions in Video 

Mac OS X includes support for playing back open and closed captioning in dynamic 
content such as movies, videos, and podcasts, using QuickTime, Front Row, and 
DVD Player. Closed captions appear in a high-contrast white font against a black 
background, similar to line 21-style television captions. You can buy and rent captioned 
movies from the iTunes Store and find captioned podcasts in iTunes U. Downloaded 
captioned content from the iTunes Store plays back with captions on iPhone, iPad, iPod 
classic, iPod nano (fourth and fifth generation), iPod touch, and Apple TV; in QuickTime 
Player (for Mac and Windows); and in iTunes (for Mac and Windows). 

To show captions in QuickTime Player: 

1	 In QuickTime Player, open the movie you want to view. 

2	 Choose View > Show Closed Captioning Note. 

This menu is available when the movie contains closed captions.

Adding Captions to QuickTime Movies 

You can also add captioning to your own content using industry-standard Scenartist 
Closed Caption files (.scc). QuickTime supports CEA-608–compliant closed captions 
that can be played back in QuickTime Player using the .scc format. An .scc file can be 
added to a QuickTime movie using Compressor, an application included with two of 
Apple’s professional digital authoring suites, Final Cut Studio and Logic Studio (available 
separately).

Using VoiceOver as a Captioning Device 

VoiceOver includes a caption panel that displays descriptions of items on the screen in 
compatible applications. Students should mute the VoiceOver voice to avoid disturbing 
others working in the same area. 

To use VoiceOver captioning: 

1	 In System Preferences, click Universal Access, then click Seeing.

2	 Click Open VoiceOver Utility. 

3	 Click Speech and select Mute Speech.

4	 Click Navigation and select “VoiceOver cursor follows mouse cursor.”

5	 Click Visuals, click the Caption Panel button, then select “Show caption panel.” (You can 
adjust the font size, number of rows, and transparency of the Caption panel here too.)

6	 Press Command-F5 to turn VoiceOver captioning on and off.
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Customizing Settings for Physical Motor Needs 
If students have difficulties using the keyboard, mouse, or trackpad, Mac OS X offers 
several built-in features that provide alternate methods to access the computer and 
communicate with others. This section describes the following options: 

•	 Sticky Keys: For pressing keys as a sequence instead of all at once 

•	 Slow Keys: For slowing down the computer’s response after a key is pressed 

•	 Key Repeat: For setting how long the computer waits before repeating a key 

•	 Mouse/Trackpad Preferences: For setting the tracking, double-click, and scrolling speed 
of a mouse or trackpad, and programming mouse shortcut buttons

•	 Mouse Keys: For using the numeric keypad instead of the mouse 

•	 Keyboard Shortcuts: For controlling the computer with keyboard shortcuts 

•	 Speech Recognition: For controlling the computer through voice 

•	 Input Menu: For using the Dvorak keyboard layout, which is designed for one-handed 
typing 
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Pressing a Group of Modifier Keys as a Sequence 

To perform many tasks on the computer, you need to press one or more modifier keys 
(Shift, Command, Option, and Control) at the same time as another key. For example, 
pressing Command-Option-D shows or hides the Dock. If students are having difficulty 
pressing several keys at once, you can make it easier for them by turning on Sticky Keys 
in Universal Access preferences. With Sticky Keys turned on, students can press a set of 
modifier keys as a sequence. As they press each key, the symbol for the modifier key 
appears on the screen. 

To use Sticky Keys: 

1	 In System Preferences, click Universal Access, then click Keyboard. 

2	 Select the On button next to Sticky Keys. 

3	 To hear a sound whenever the computer registers that you have pressed a modifier 
key, select “Beep when a modifier key is set.” 

4	 To see an icon indicating which modifier key you have pressed, select “Display pressed 
keys on screen.” 

Making the Keyboard Respond More Slowly When Keys Are Pressed 

The Slow Keys setting in Keyboard preferences can be used to increase the length of 
time between when a key is pressed and when it is activated by the computer. This 
helps to prevent unintended multiple keystrokes by students who may have difficulties 
with pressing keys quickly. 

To use Slow Keys: 

1	 In System Preferences, click Universal Access, then click Keyboard. 

2	 Select the On button next to Slow Keys. 

3	 Drag the Acceptance Delay slider to set how long you want the computer to wait after 
the key is pressed. 

4	 To hear a sound whenever the computer registers that you have pressed a key, select 
“Use click key sounds.” 

Adjusting Repeating Key Rate 

You can also set how long the computer waits before it begins to repeat a key that is 
being pressed by adjusting the Key Repeat Rate. If students hold down a keyboard key 
when the insertion point is in a text area, the character begins to repeat. You can set 
how long they must hold down the key before the character starts repeating and how 
fast it repeats once it starts. Students who have limited motor control will find that this 
feature prevents the frustration of trying to maintain just the right amount of pressure 
on the keyboard to get a single letter instead of multiple letters. 
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To set the key repeat rate: 

1	 In System Preferences, click Keyboard. 

2	 In the Keyboard pane, drag the Key Repeat Rate slider to set how fast characters repeat. 

3	 Drag the Delay Until Repeat slider to set how long to wait before the character begins 
repeating. 

Using the Numeric Keypad to Control the Mouse Pointer 

If students have difficulty using the mouse, they can use the numeric keypad to move 
the mouse pointer and click items on the screen. This is done by turning on the Mouse 
Keys option in the Universal Access preferences. With Mouse Keys turned on, students 
can press the 5 key on the numeric keypad to click an item on the screen, press the 
surrounding 1 through 9 keys to move the cursor, press the 0 key to press and hold the 
pointer on an item, and press 5 again to release the press and hold. 

To set up Mouse Keys: 

1	 In System Preferences, click Universal Access, then click Mouse or Mouse & Trackpad. 
(The name of the option varies depending on whether the computer is a notebook or 
desktop model.) 

2	 Select On next to Mouse Keys. 

3	 Drag the Initial Delay slider to set how long to wait before the pointer moves. 

4	 Drag the Maximum Speed slider to set how quickly the pointer moves. 

5	 To be able to turn Mouse Keys on or off from the keyboard, select ”Press the Option key 
five times to turn Mouse Keys on or off.” 

Using Keyboard Shortcuts to Navigate 

Students who have difficulties using the mouse or trackpad can use keyboard shortcuts 
to access the menu bar, Dock, and other areas on the screen. The specific keyboard 
shortcuts can be customized in Keyboard preferences. Students can also use the key
board to quickly switch between open applications with the Command and Tab keys. 

For more information about these options, see “Navigating with Keyboard Shortcuts,” 
earlier in this guide. 

Using Speech Recognition to Control the Computer 

Students who find it difficult to use the mouse, trackpad, or keyboard can use their 
voices to control the computer and applications by using the Mac OS X built-in speech 
recognition technology. They can speak certain phrases, or “spoken commands,” to 
make the computer take different actions, such as opening documents or switching 
applications. 

Apple’s speech recognition is speaker-independent, so you don’t have to train it to 
your own voice. The MacBook, iMac, and MacBook Pro include a built-in microphone 
that can be used for speech recognition. A headset and microphone combination is 
recommended when using speech recognition in noisier classroom environments.

For more information about speech recognition, see “Using Spoken Commands to 
Control the Computer,” earlier in this guide. 
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Using a Dvorak Keyboard Layout for One-Handed Typing 

A keyboard layout determines what characters appear when students press a key on 
the keyboard. With Mac OS X, many language input methods are available, enabling 
students to type in languages that use a different writing system (or “script”) from their 
own without having the physical keyboard that’s designed for that language. 

In addition to the standard QWERTY keyboard layout, Mac OS X includes several 
Dvorak keyboard layouts that may be useful for those who have difficulty typing. The 
traditional Dvorak keyboard layout places the most commonly used keys under your 
fingers. The Dvorak-Left and Dvorak-Right layouts place the most commonly used keys 
under your left or right hand, respectively, reducing the need to move your hands and 
fingers.

When students choose a keyboard layout that’s different from the keyboard they have, 
the keys they see (and press) on the physical keyboard may be different from the 
characters that are displayed when they type. Students can use the Keyboard Viewer to 
see the location of characters on the keyboard. 

To use a Dvorak keyboard layout: 

1	 In System Preferences, click International, then click Input Menu. 

2	 Select the checkbox next to Keyboard Viewer. 

3	 Choose between Dvorak, Dvorak–Left, Dvorak–Qwerty, and Dvorak–Right and select the 
appropriate checkbox. (You’ll need to scroll to locate these layouts.) 

4	 Select the “Show input menu in menu bar” checkbox. 

5	 Click the input menu icon (the flag) in the upper-right corner of the menu bar on the 
desktop. 

6	 Choose the keyboard layout you want from the menu and start typing. 

7	 Choose Show Keyboard Viewer from the Input menu to see the location of the 
characters on the keyboard. 
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Using the Applications on a Mac 
with Diverse Learners 
Every new Mac computer comes with powerful software to 
assist students with their work. They can conduct research with 
Safari, pull up a world of knowledge with Dashboard widgets, 
collaborate with iChat, keep track of homework with iCal, share 
knowledge with digital media projects via iLife, and much 
more. Additional Apple applications, such as iWork, can be 
purchased to complement these tools.

With a broad range of versatile tools, every learner will easily find more ways to 
improve their skills and to express themselves creatively. The following sections 
introduce the applications, suggest how they may be helpful to learners with different 
needs, and provide resources for more information. 

Communicating and Collaborating with iChat
A powerful yet easy-to-use communication application, iChat allows students to 
connect with others via video, audio, and text. Through video conferences, audio 
conferences, instant text messages, and the ability to send and receive files, students 
can get just-in-time assistance with their projects by sharing information with others in 
the next classroom or by learning from experts in remote locations across the globe. 

iChat offers many ways to support diverse learners in the classroom, such as: 

•	 Students who are deaf can readily communicate with others using sign language via 
video conferences. 

•	 Students with vision impairments or those developing language proficiency can use 
audio chats to speak together while collaborating on a project. 

•	 Students can collaborate on class projects by using text chats to engage in written 
conversations and to transfer files and photos, an especially useful tool for those with 
hearing impairments. 

•	 Students can collaborate with others on projects by using iChat screen sharing to 
observe and control a single desktop. iChat initiates the connection (asking permission 
first), automatically initiates an audio chat so students can talk through things while 
sharing a screen, and allows both parties to control the screen at all times. Students can 
even drag files from one computer to the other while screen sharing.
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•	 You can monitor students’ language development by recording their iChat audio and 
video conferences and keep track of writing progress by saving their text chats. iChat 
asks permission from the different parties beforehand and then stores audio chats as 
AAC files and video chats as MPEG-4 files so they can be shared or synced with iPad  
or iPod. These files can also be shared with students’ families.

•	 English language learners can practice their English and also communicate in their 
heritage language in video intercambios, cultural exchanges, in which students in the 
classroom collaborate on projects with students in other parts of the world. 

•	 Students and families can use iChat capabilities to maintain the home/school 
connection if students are unable to attend school due to illness or travel. 

It’s easy to set up iChat to communicate with text, audio, and video. For instant text 
messages and audio conferences (with up to ten people), you just need iChat and a 
Mac computer with a built-in microphone. For video conferences (with up to three 
participants), you need a Mac with iChat, a broadband Internet connection, and an 
iSight camera, which now comes built in to every new MacBook, MacBook Pro, and iMac. 

For students to be able to chat with others who aren’t on the same local network, they 
will need an instant messaging address, also known as a screen name, which can be a 
MobileMe account name, an AIM or AOL screen name, or a jabber screen name (to chat 
with jabber buddies). 

Many schools are now using iChat Server included with Mac OS X Server to set up their 
own secure, private IM servers for students to collaborate with each other. You can also 
use Parental Controls in System Preferences to designate which people students may 
chat with. 

To get started with iChat: 

1	 Open the iChat application, located in the Dock and in the Applications folder. 

2	 When a person in your Buddy List is connected to the Internet and logged in to iChat, 
the person is listed as “Available” in your Buddy List. (Choose Buddies > Add Buddy to 
add someone to your Buddy List.) 

3	 To send a message, double-click the person’s name. When your buddy replies, the 
response appears on your screen. 

A video icon next to the person’s name means that person is available for a video 
conference; a phone icon indicates that you can have an audio chat. 

4	 To share a screen in iChat, initiate a chat, then choose Buddies > Share My Screen. (Be 
sure that Screen Sharing Enabled is checked in the Video menu.)

Learn More About iChat

n	 Choose Help > iChat Help to see onscreen help information. 

You can also visit the following iChat Support website for articles, tutorials, user 
discussions, and more at: www.apple.com/support/ichat

http://www.apple.com/support/ichat
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Exploring Words with an Accessible Dictionary 
Mac OS X includes a dictionary application that provides access to a fully searchable 
copy of the New Oxford American Dictionary, the Oxford American Writer’s Thesaurus, 
and Wikipedia (accessible when you’re connected to the Internet). As students begin 
typing the word they are seeking, Dictionary displays a list of words from which to 
choose. Dictionary entries include a pronunciation guide and parts of speech as well 
as a definition. Some entries include sample sentences that use the word, and others 
include images to reinforce meaning. 

Students struggling with sequencing often spend more time thumbing through pages 
of a dictionary than they do accessing definitions. Because Dictionary allows students 
to type a word to look it up, many students will find it much easier to locate the 
information they need. 

Dictionary also offers quick ways students can look up a word when working in many 
applications, such as TextEdit and Safari, without needing to first open Dictionary 
and type a word. These options can be especially helpful for students with reading 
difficulties who are trying to understand challenging text. Students with reading 
difficulties or who are English language learners may find that hearing the entries read 
aloud provides a rich medium for language development. 

To get started with Dictionary:

1	 Double-click the Dictionary application icon, located in the Applications folder. (You can 
add the icon to the Dock for easier access.) 

2	 Click Dictionary or Thesaurus, depending on which resource you want to use, or click 
All if you want to see all the dictionary, thesaurus, and Wikipedia entries for a word.

3	 Type a word and then select the word you want from the list that appears. 

4	 To hear the entry read aloud, select the text and choose Dictionary > Services >  
Speech > Start Speaking Text. 

To look up a word’s definition when working in many applications, such as Safari: 

n	 To open the Dictionary entry, select and then Control-click the word (or right-click 
using a Mighty Mouse), then choose Look Up in Dictionary from the shortcut menu. 
Alternatively, select the word and choose [Application Name] > Services > “Look Up in 
Dictionary.” 

n	 To display a floating window with the word’s definition, place the pointer on the word, 
then press Command-Control-D. 

Learn More About Dictionary 

n	 Choose Help > Dictionary Help to see onscreen help information. 
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Promoting the Strengths of All Learners with iLife 
The iLife suite of applications offers a powerful set of tools for students to represent 
their learning with media-rich digital projects. iLife provides versatile visual, auditory, 
and three-dimensional tools to present information and concepts to students in ways 
other than lectures or reading assignments. 

iLife ’09 includes five highly integrated and easy-to-use applications: 

•	 iPhoto for importing, organizing, editing, and sharing photos and other images 

•	 iMovie for combining video, sounds, pictures, and text in digital movies 

•	 GarageBand for creating and recording music and podcasts and for learning how to 
play instruments 

•	 iWeb for creating web pages that can include photos, movies, blogs, and podcasts 

•	 iDVD for producing DVDs to store and share digital media projects (requires a Mac 
computer with a SuperDrive or a third-party DVD burner) 

While all students benefit from using iLife to express ideas and showcase expertise, 
these tools are particularly powerful for diverse learners. Allowing students to present 
their understanding in the modality that best represents their strengths is a benefit to 
teachers and students alike. For instance, auditory learners might use GarageBand to 
create a spelling or poetry podcast, while visual learners might choose an iPhoto photo 
book or slideshow to demonstrate geometric shapes—all are activities that excite and 
engage students and provide you with assessment information. These methods can be 
particularly powerful for students who have disassociated themselves from traditional 
textbook learning. 

In addition, English language learners and students with special needs often require 
some sort of remediation, which usually takes the form of worksheets and drill and 
practice activities. While the development of basic skills is essential to academic 
success, using the iLife tools provides fertile ground for student success in school and 
beyond. For instance, students who are developing proficiency in English could make 
movies of each other taking part in dialogues that use key vocabulary words and then 
replay the movies to further reinforce their learning. 

Another benefit of the iLife applications is that they’re all designed to work with each 
other and with other Apple applications, so it’s easy to use media from one application 
in another. For example, photos in an iPhoto library can be readily added to a Keynote 
presentation, a podcast created with GarageBand, an iMovie project, or a report 
created with Pages. Just click to open the Media Browser in the application in which 
you’re working and you have instant access to your entire photo library. This means 
technology takes less mental energy for students to use, and they have more time and 
energy to focus on assignments. 

The next sections describe the applications included with iLife ’09 and include 
suggestions for how you might use them with your students. 
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Supporting Visual Learning with iPhoto
iPhoto is a versatile application for organizing, editing, and sharing photos and other 
images. Images can be imported into iPhoto from a camera, website, DVD, or CD. 

For example, you can scan student artwork into the computer and import those 
images into iPhoto to share with the class and students’ families. When you import 
photos, iPhoto automatically groups the images into Events, which are based on when 
the photos were taken. Each Event is displayed in iPhoto with a name that you add 
and one of the images from the Event, which you can change. With the Faces feature, 
you can organize photos by the specific people in them, and the Places feature lets 
you categorize photos by where they were taken. This organization makes it easy for 
students, especially visual learners, to quickly find what they’re looking for in an iPhoto 
library. Once images are imported, they can be enhanced with iPhoto editing tools.

iPhoto provides you with a number of ways to share the images, including slideshows, 
photo books, calendars, web pages, and more. You can even create a class album of 
images on your computer and share it with student computers so students can use 
your images in their projects. 

With a digital camera and iPhoto, you and students can capture in a concrete visual 
way many of the aspects of learning that are traditionally print-oriented. This can aid 
many students, including those who are struggling readers, developing English skills, 
and especially strong in expressing themselves visually. Examples of such projects 
produced with iPhoto include: 

•	 Flash cards that combine text and photos for students to study vocabulary, math facts, 
and other information 

•	 Student reports illustrated with images from iPhoto albums 

•	 A teacher-created photo book of the math problem of the week that includes pictures 

•	 Teacher-created iPhoto slideshows to present lab instructions with images 

•	 Web pages produced by students with images that illustrate concepts in a unit of study 

To open iPhoto: 

n	 Click the iPhoto icon in the Dock or double-click the icon in the Applications folder. 

Learn More About iPhoto 

n	 Choose Help > iPhoto Help to see onscreen help information, or visit the following 
websites: 

	 Get an overview of iPhoto at: www.apple.com/ilife/iphoto 

	 Take an iPhoto tutorial to learn how to make iPhoto projects at:  
www.apple.com/ilife/tutorials/iphotoLearn 

	 Access articles, discussion boards, tutorials, and other resources on the iPhoto  
Support page at: www.apple.com/support/iphoto

http://www.apple.com/ilife/iphoto
http://www.apple.com/ilife/tutorials/iphotoLearn
http://www.apple.com/support/iphoto
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Presenting Digital Stories with iMovie
With iMovie, students are able to tell a story and communicate meaning through video, 
audio, narrations, still images, and text. iMovie is simple to use yet provides everything 
needed to make professional-looking movies. Features of iMovie include: 

•	 Quick import of video clips from a digital video camera 

•	 Ability to add still images from iPhoto, music created in GarageBand, or audio stored in 
iTunes 

•	 Tools that allow students to crop clips and do other editing tasks, such as add 
transitions, titles, and more 

When a movie is finished, it can be added to a web page, sent to an iPad or iPod, 
copied to a CD, or sent to iDVD to produce a DVD, complete with menus and 
navigation tools (available on computers that have a SuperDrive). 

iMovie offers many ways to aid diverse learners in the classroom, including: 

•	 Students with writing difficulties may find the process of writing a script, with its 
inclusion of visual and audio elements and the excitement of “making a movie,” more 
engaging than other kinds of narrative writing assignments. 

•	 For visual learners, producing movie projects provides opportunities to use their visual 
spatial strengths while developing their storytelling skills. 

•	 Working on movie projects helps students who struggle with sequential ordering to 
strengthen those skills. 

•	 iMovie projects are ideal for student collaboration—with the many different types of 
skills needed to produce a movie, all students are able to contribute in ways that both 
showcase their strengths and build their skills. 

•	 Captions can be added with subtitles in iMovie or added to the finished movies (see 
“Adding Captions to QuickTime Movies,” earlier in this guide) for students who are deaf 
or hard-of-hearing and for English language learners. The captioned movies can also be 
used to help strengthen reading skills. 

You can use a digital video camera to capture yourself introducing key skills and 
concepts. Students can then view these movies on a computer at home for review or 
support while they are doing their homework or to catch up on assignments when 
they have been absent. You can also catalog these movies for future classes. 

To open iMovie: 

n	 Click the iMovie icon in the Dock or double-click the icon in the Applications folder. 

Learn More About iMovie

n	 Choose Help > iMovie Help to see onscreen help information, or visit the following 
websites:  

	 Get an overview of iMovie at: www.apple.com/ilife/imovie

	 Take an iMovie tutorial to learn how to make iMovie projects at:  
www.apple.com/ilife/tutorials/imovie

	 Access articles, discussion boards, tutorials, and other resources on the iMovie Support 
page at: www.apple.com/support/imovie 

http://www.apple.com/ilife/imovie
http://www.apple.com/ilife/tutorials/imovie
http://www.apple.com/support/imovie
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Using GarageBand to Communicate with Sound 
With GarageBand, students are able to easily create a song, produce a podcast, record 
a reading sample, score a movie, and learn how to play an instrument. GarageBand 
comes with hundreds of musical loops and sounds for students to use in creating 
their own songs. It also includes the Magic GarageBand feature, which allows students 
to compose songs with a virtual onstage band in minutes. Students can record their 
own performances, either solos or in groups—an excellent way to showcase students’ 
musical skills or interests. Students can also use the tools in GarageBand to produce 
their own podcasts—recorded audio files that are posted on the Internet and that can 
be subscribed to by others. 

The following are just some of the ways you might want to use GarageBand with the 
diverse learners in your classroom: 

•	 Students who have difficulty with memorizing math facts, formulas, vocabulary words, 
and definitions can put them to music, create raps, or produce their own auditory study 
guides with background music. They can then review them as often as needed on a 
computer, an iPad, or an iPod, turning “remedial instruction” into a “cool” activity. 

•	 With GarageBand, you can create podcasts to help students review important concepts 
or assignments for students to use at home to help them with homework or study for a 
test. 

•	 Students can work at their own pace to learn how to play an instrument with a new 
series of interactive lessons for learning piano and guitar.

•	 Students can record themselves reading, which allows them to play back what they’ve 
read and do self-evaluations, building to self-corrections. 

•	 Students can make audio recordings of books for younger children to use to read 
along, giving themselves reinforcement of reading skills and engaging them in reading 
for a real audience. 

•	 GarageBand provides the means for you to easily record lectures that students can 
then review, which is especially useful for auditory learners and those who have 
difficulties with note-taking. 

To open GarageBand: 

n	 Click the GarageBand icon in the Dock or double-click the icon in the Applications 
folder. 

Learn More About GarageBand 
n	 Choose Help > GarageBand Help to see onscreen help information, or visit the 

following websites:  

	 Get an overview of GarageBand at: www.apple.com/ilife/garageband

	 Take a GarageBand tutorial to learn how to compose songs, create podcasts, and more 
at: www.apple.com/ilife/tutorials/garageband

	 Access articles, discussion boards, tutorials, and other resources on the GarageBand 
Support page at: www.apple.com/support/garageband

http://www.apple.com/ilife/garageband
http://www.apple.com/ilife/tutorials/garageband
http://www.apple.com/support/garageband
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Sharing Student Work with iWeb 
Sharing student work on a website—with a real audience and purpose—provides 
a powerful incentive for students. With iWeb, it’s simple to create web pages. Just 
select one of the predesigned templates and add students’ images, movies, text, blogs, 
podcasts, and other audio. The site can then be published with one click to the school 
server without the use of an FTP or published on the Internet via a MobileMe account. 

Students with writing difficulties may find writing blogs an engaging way to develop 
their skills. (A blog is a series of text entries on a web page, similar to a journal.) 
Students can use iWeb to set up a blog with news of the classroom, a reading log, or a 
report on the progress of science experiments. As they write new entries, they can also 
attach artwork, videos, photos, or audio files. 

iWeb can promote the home/school connection as it provides a simple method for 
you to keep students’ families informed of the work they’re doing in the classroom. 
Each student’s site created with iWeb can provide a space for his or her podcasts and 
blogs, with built-in subscriptions via RSS so that families and friends can get automatic 
updates on the student’s activities and accomplishments. The opportunity to highlight 
student strengths provides a means for every student to feel a valued part of the class, 
especially for students who have not been recognized for academic success in the 
traditional ways. 

To open iWeb: 

n	 Click the iWeb icon in the Dock or double-click the icon in the Applications folder. 

Learn More About iWeb 

n	 Choose Help > iWeb Help to see onscreen help information, or visit the following 
websites:  

	 Get an overview of iWeb at: www.apple.com/ilife/iweb

	 Take an iWeb tutorial to learn how to create blogs, websites, and more at:  
www.apple.com/ilife/tutorials/iweb

	 Access articles, discussion boards, tutorials, and other resources on the iWeb Support 
page at: www.apple.com/support/iweb

http://www.apple.com/ilife/iweb
http://www.apple.com/ilife/tutorials/iweb
http://www.apple.com/support/iweb
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Accessing Internet Information with Safari 
Safari, the simple-to-use web browser that comes with every Mac, includes a built-in 
Google search box in the address bar, tabbed browsing, and the ability to receive the 
latest news and information via RSS (Really Simple Syndication) technology. (With RSS, 
you subscribe to sites, such as news and community organizations, that offer such news 
feeds. Articles from these sites then appear in an ad-free list in Safari, an easy way for 
all students to stay up to date.) 

With tabs in Safari, students can quickly switch between multiple web pages in a 
single window. This enables students to quickly and easily compare information on a 
subject from multiple sources, which can help them learn how to evaluate information 
presented on the Internet. Tabs can be moved by dragging them in the tab bar and 
can be separated by dragging them into a new window. You may find it helpful to set 
up such tabs for a group of sites you want students to visit, especially when students 
might have difficulty searching or navigating the web browser on their own. 

Bookmarks are another way to organize a group of sites for students to access. You 
can add bookmarks for those sites to the Safari Bookmarks bar and students just click 
the name to go to the site. You can even bookmark a set of tabs so you only have to 
set them up once. By using Parental Controls in System Preferences, you can limit the 
specific sites that students are allowed to browse. (For more information, see “Setting 
Up Individual User Accounts on a Computer,” earlier in this guide.) 

Safari has other features that may be beneficial to students with a variety of needs, 
including: 

•	 Students can hear selected text read aloud, an essential resource to access text at 
or above their reading level as well as for students with visual needs. (For more 
information, see “Hearing the Computer Speak Selected Text,” earlier in this guide.) 

•	 Students who are beginning readers or have visual needs will appreciate the ability to 
enlarge print on any web page by clicking the Text Size icon. 

•	 Students who have problems with attention may find it helpful to use the search bar 
to instantly and graphically locate any text on the current web page. When a search 
is underway, Safari highlights every instance of the word being searched for and even 
dims the rest of the page. This can make it easier for students to focus on the results of 
their search. 

•	 Students can take advantage of the note-taking assistance offered through the Services 
command—they can save selected text in a sticky note on the desktop or in a new 
TextEdit document or summarize selected text. These features can be especially helpful 
for students who have problems with attention, writing, or reading, or who are English 
language learners. (For more information, see “Getting Note-Taking Support and More 
with the Services Command,” earlier in this guide.) 
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To open Safari: 

n	 Click the Safari icon (the compass) on the Dock or double-click the icon in the 
Applications folder. 

To add the Text Size icon to the address bar: 

1	 Choose View > Customize Address Bar. 

2	 Drag the Text Size icon into the address bar. Now students can click the Text Size icon 
to enlarge text on any website. 

To search within a web page: 

1	 Choose Edit > Find > Find. A search bar appears.

2	 Type a word into the search field at the right end of the search bar.

3	 Click the left and right arrows to reverse the direction of the search.

Learn More About Safari 

n	 Choose Help > Safari Help to see onscreen help information, or visit the following 
websites: 

	 Get an overview of Safari at: www.apple.com/macosx/what-is-macosx/safari.html

	 Access articles, discussion boards, tutorials, and other resources on the Safari  
Support page at: www.apple.com/support/safari

http://www.apple.com/macosx/what-is-macosx/safari.html
http://www.apple.com/support/safari
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Finding Information Quickly with Dashboard Widgets 
All learners will appreciate the specificity and simplicity of widgets—small applications 
that perform one or two specific tasks, enabling students to quickly access information 
without the need to open an application. Widgets are part of the Dashboard 
application—when the application is opened, a semi-transparent layer of widgets 
appears over the user’s desktop. Each user on a computer can have a different set of 
widgets to access when Dashboard is open. 

Many widgets come with Mac OS X and thousands more are available on the 
Dashboard Widgets website. You can even build your own widgets with the Web Clip 
feature in Safari, clipping a portion of a web page you want and placing it on your 
Dashboard. Whenever that portion of the web page changes, the widget updates as 
well. To use some widgets, you must be connected to the Internet. 

You may want to review your curriculum, class assignments, and assessments to 
determine which widgets might be most helpful in keeping students on track and 
organized. You can help students analyze their learning profile and select or build 
widgets that maximize their strengths and help them work around their learning 
challenges. Because each user has his or her own customizable Dashboard, you can 
choose a selection of widgets that will best meet a student’s specific needs—widgets 
that will allow them to practice skills, organize their time, locate information, and 
translate languages. 

Some educator-recommended widgets useful in classrooms include: 

Widgets Included with Mac OS X 

Dictionary 

Quickly find definitions, thesaurus entries, synonyms, antonyms, and more. 

Translator 

Translate words and phrases instantly between 12 languages. 

Calculator 

Perform basic calculations quickly and easily (not all features in the Calculator 
application are available with the widget). 

Unit Converter 

Convert numerous units of weight and measure, including area, currency, length, speed, 
temperature, and more. 

Calendar 

Get at-a-glance access to daily and monthly calendars. 

Widgets Available for Download 

www.apple.com/downloads/dashboard

PixAide by Slater Software 

Type a word and find a picture symbol that communicates the concept. 

http://www.apple.com/downloads/dashboard
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Countdown Plus by Steven Chaitoff 

This simple widget counts down to a user-specific date and event. This is especially 
helpful for keeping track of project due dates. 

NASA Asteroid Watch by Jet Propulsion Laboratory 

Students can track asteroids and comets as they approach Earth and find out 
information about each one.

ProVoc Widget by Arizona Software 

Students can keep learning and repeating vocabulary at any time. 

Species Distribution Map from GBIF

This widget displays a distribution map for a species (or any taxon) from the GBIF data 
network.

To get started with Dashboard: 

1	 Click the Dashboard icon in the Dock or press the Dashboard key (F4, F12 on older 
models) to open Dashboard. 

2	 Click the Open (+) button to reveal the widget bar and access your widgets. Click the 
Close (x) button to hide the widget bar. 

3	 To open a widget, click its icon or drag it out of the widget bar. 

4	 Use the arrow buttons on the widget bar to see other available widgets. 

5	 To return to the desktop, press the F4 (or F12) key or click the desktop. 

6	 To add more widgets, when Dashboard is open, click the Open (+) button to open the 
widget bar, click Manage Widgets, then click More Widgets. 

To create your own widget from a web page: 

1	 Open the web page in Safari. 

2	 Click the Web Clip icon (the icon with scissors at the top right of the window) and drag 
to select the portion of the page you want.

3	 Click Add to see the new widget spring to life on your Dashboard. The widget is “live” 
and will update as its page of origin changes.

Learn More About Widgets 

Visit the following website to download additional widgets:  
www.apple.com/downloads/dashboard

http://www.apple.com/downloads/dashboard
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Keeping Track of and Managing Tasks with iCal 
iCal is an easy-to-use calendar application included with every Mac computer. The iCal 
window looks like a typical calendar with month, week, and day views, but one element 
that sets it apart is its color-coded categories feature. Now students can organize their 
homework for different classes and other important school dates in one calendar. 

Students with organizational difficulties will find iCal particularly helpful because they 
can use it to quickly organize a wide variety of data in one place. Features of iCal that 
they can use to improve their classroom performance include: 

•	 To Do lists: Students can use these lists to keep track of upcoming assignments or tests. 

•	 Info pane: This is where students can add details about assignments. 

•	 Search feature: Students can easily search for specific upcoming assignments instead of 
reading all entries in a calendar. 

•	 Alarms: Calendars can be set up so that students will see or hear one or more alarms 
before or after an event or to-do item occurs. Teachers can use iCal to publish 
homework calendars via the Internet that update automatically when changes are 
made. By subscribing, students and parents are able to stay up to date on dates for 
assignments, tests, and class events. 

To open iCal: 

n	 Double-click the iCal icon, located in the Applications folder. 

Learn More About iCal 

n	 Choose Help > iCal Help to see onscreen help information, or visit the following 
websites: 

	 Get an overview of iCal at: www.apple.com/macosx/features/ical 

	 Access articles, discussion boards, tutorials, and other resources on the iCal  
Support page at: www.apple.com/support/ical

http://www.apple.com/macosx/features/ical
http://www.apple.com/support/ical
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Supporting Written Work with TextEdit 
Every Mac includes TextEdit, an easy-to-use application for viewing, creating, and 
editing text. With TextEdit, students can quickly create documents they can share with 
one another—from notes taken in class to a paper that needs to be proofread. TextEdit 
documents can include tables, images, and movies. You can use TextEdit, for example, 
to format class worksheets that include columns with different categories for students 
to fill out, which can help students with organizational difficulties to stay on task. 

TextEdit offers many additional ways to support students’ writing projects, including: 

•	 Spelling checker: One feature of the spelling checker is that students can check the 
spelling in their documents as they type, providing extra support for those who have 
difficulties with spelling. 

•	 Support for multiple languages: TextEdit documents can include text in multiple 
languages within the same document, including those that use characters not on 
the standard keyboard, such as Japanese and Chinese. This can be an aid to English 
language learners in the classroom. (For more information, see “Customizing Settings 
for Multiple Languages,” earlier in this guide.) 

•	 Links to websites: TextEdit documents can contain hyperlinks to websites, a way for you 
to provide students with documents that they can use onscreen to quickly navigate to 
a relevant website, without the need to open a browser and type a URL. 

•	 Text-to-Speech: Many students, such as English language learners, struggling readers, or 
those with visual impairments, may find it helpful to hear text in a TextEdit document 
read aloud. This can be text they wrote or text copied from a web page or another 
source. (For more information, see “Hearing the Computer Speak Selected Text,” earlier 
in this guide.) 

•	 Summarize: English language learners and struggling readers and writers especially 
will appreciate this feature, available from the Services command in the TextEdit menu, 
that allows them to summarize selected text. (For more information, see “Getting Note-
Taking Support and More with the Services Command,” earlier in this guide.) 

To open TextEdit: 

n	 Double-click the TextEdit icon, located in the Applications folder. (You may want to add 
the icon to the Dock for easy access.) 

Learn More About TextEdit 

n	 Choose Help > TextEdit Help to see onscreen help information. 
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Improving Math Skills with Calculator and Grapher 
Every Mac includes two applications ready to improve student mathematical 
performance: Calculator and Grapher. Calculator provides users with a basic, scientific, 
and programmer’s calculator. In addition to performing numerical calculations, students 
can also use Calculator to convert units of measurements, allowing them to focus on 
the mathematical concepts instead of on basic calculations. Students can use either the 
keyboard or mouse to enter data. 

Here are some of the ways Calculator can help the diverse learners in your classroom: 

•	 With text-to-speech, students needing auditory feedback can hear numbers and totals 
read aloud. This feature can also help students who are developing English proficiency 
to reinforce the names for numbers and other mathematical concepts. 

•	 The View Paper Tape feature provides visual reinforcement for students who will benefit 
from having a record of the steps they’ve used and the results at each step as they are 
developing higher-level thinking skills. 

•	 Students with a math-related learning disability such as dyscalculia may want to use 
the Calculator on a daily basis. 

Grapher, a full-featured 2D and 3D equation graphing application included on every 
Mac, provides visual learners with graphical representations of mathematical concepts. 
Students can create many different types of 2D and 3D graphs and then analyze the 
results. Completed graphs can be saved as PDF files and then used in other applications, 
such as in printed study guides or presentations. You and your students can also use 
the features of Grapher to construct QuickTime movies to demonstrate any equation 
that uses a parameter that you’ve defined, and then present the animation to the 
class. For students who need extra practice and reinforcement, these concrete learning 
representations can make mathematics more real. 

To open Calculator: 

n	 Double-click the Calculator icon located in the Applications folder, or click its icon in 
the Dock. 

To hear names of buttons or keys pressed or results read aloud: 

n	 In Calculator, choose Speech > Speak Button Pressed or Speak Result. 

To open Grapher: 

n	 Double-click the Grapher icon, located in the Utilities folder. (You may want to add 
the icon to the Dock.) 

Learn More About Calculator and Grapher 

n	 In Calculator, choose Help > Calculator Help to see onscreen help information. 
In Grapher, choose Help > Grapher Help to see onscreen help information. 



42 Getting Started: 
Apple Technology for Diverse Learners

Creating, Publishing, and Presenting with iWork
iWork provides three powerful applications that students can use for communicating 
in today’s world: Pages—a streamlined word processor; Keynote—for creating cinema-
quality presentations; and Numbers—an innovative spreadsheet program. 

iWork provides students with tools for communicating in today’s world. Using iWork, 
students also can express their visual and creative side with these three easy-to-use 
applications. Students can use Pages to create all sorts of documents that combine 
text with supporting images, videos, graphs, charts, and more. Templates in Pages 
give students a choice of professionally designed layouts they can use to get a head 
start on structuring a document. Keynote allows students to produce cinema-quality 
presentations that give them the confidence to stand in front of peers and speak from 
a position of expertise. Keynote presentations can include video, audio, photos and 
other images, text, and even three-dimensional graphs, all easily combined in a choice 
of templates. With Numbers, students can choose a blank sheet, a grid with empty rows 
and columns, or open a preformatted template—one they can quickly customize and 
populate with graphs, tables, and charts. Calculations are made by simply dragging one 
of the built-in formulas to cells or by using common phrases like “total cost.”

The seamless integration of iWork with iLife means, for example, that students 
can easily use their images from iPhoto in a Pages document or a movie created 
with iMovie in a Keynote presentation. The Media Browser that’s used in the iLife 
applications is part of the iWork applications as well, allowing ready access to media 
files. Students can even take a prerecorded audio file from iTunes and add it to an 
iWork document. 

Keynote’s speaker notes and the Presentation Display feature make it easy for even  
the least confident presenters to do a polished job of sharing their project. Students 
who are more comfortable being the center of attention (positively or negatively) 
rather than doing traditional learning tasks can find success presenting with Keynote. 

To open Pages, Keynote, or Numbers: 

n	 Click the Pages, Keynote, or Numbers icon located in the iWork folder in the 
Applications folder. 

Learn More About iWork 
n	 Choose Help > Pages Help, Keynote Help, or Numbers Help to see onscreen help 
information.  You can also visit the following websites: 

	 Get an overview of iWork at: www.apple.com/iworkInformation

	 Take an iWeb tutorial to learn how to create documents, presentations, and 
spreadsheets at: www.apple.com/iwork/tutorials

	 Access tutorials, articles, and discussion boards at: www.apple.com/support/iwork

http://www.apple.com/iworkInformation
http://www.apple.com/iwork/tutorials
http://www.apple.com/support/iwork
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Setting Up and Personalizing  
iPad or iPod touch for Diverse 
Learner Needs

The iPad and iPod touch are easy-to-use mobile devices. They can be used to store 
and play audio and videos, view images, and access the Internet. You and students 
can use the productivity applications that come with iPad and iPod touch to send 
and receive email, take notes, keep calendars and contact files, access Google Maps, 
and much more. And by choosing from hundreds of education applications available 
for download from Apple’s App Store, teaching and learning is expanded even more. 
Students can view the stars, learn a language, review math facts, and learn about 
history.

With an iPad or iPod touch, you can copy and paste from application to application, 
such as text from a web page to a note. Both devices can also be connected to a TV 
or projection device (with an added AV cable) to display slide presentations and other 
files. And, by using earphones with a built-in microphone or a third-party microphone 
(sold separately), iPod touch can be used to record any kind of audio file—from class 
lectures to poetry readings.

Using the Applications Included with iPad or iPod touch
The applications that come with iPad or iPod touch offer a valuable set of resources 
that support teaching and learning in the classroom. This section provides an overview 
of many of these applications. 

Music

With the Music app, you can access content that’s been downloaded from iTunes and 
iTunes U, including enhanced podcasts, audiobooks, student voice recordings, famous 
speeches, songs, and more. Content can be synced from an iTunes library to an iPad or 
iPod touch. 

The Music app gives educators a great deal of flexibility in creating learning resources 
for students. You can download content from iTunes U in the iTunes Store to create 
playlists of content relevant to specific lessons and topics. You may want to create a 
playlist of podcasts to assist auditory learners with understanding key concepts while 
also putting together a playlist of videos covering the same topic to assist visual 
learners. Or you might add an enhanced podcast combining the audio track with 
images to support both learning styles. 

You can also create your own podcasts to reinforce topics covered in class or to give 
students further insight into a particular topic. All of these audio and video resources 
can be managed in iTunes and synced to your device. 
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Students can also use the Music app to keep their files organized and create playlists  
of their own. English language learners may want to download audiobooks from  
iTunes U to help with their comprehension and language skills, while students in 
foreign language classes can access podcasts in that language to further their language 
acquisition. 

With the Music app, students have access to audio files they’ve created, making it a 
great way for students who have trouble taking notes in class to access lectures they’ve 
recorded. English language learners and others can play back recordings of themselves 
reading aloud to practice English and gain proficiency. (Not applicable on iPad.) 

If students are connected to the Internet via Wi-Fi, tapping the iTunes icon from the 
Home screen takes them directly to the iTunes Store where they have direct access to 
content, including iTunes U resources. Thus, as students work on a project, they could 
find content related to that project in iTunes U and download it directly to iPad or  
iPod touch. 

To open the Music app:

n	 Tap Music on the iPad or iPod touch Home screen.

Photos 

The Photos app enables students to share photos with teachers, fellow students, friends, 
and family. With the Photos app, students have access to their photo library. They can 
flick to scroll through thumbnails, tap a thumbnail to view the photo full screen, rotate 
to see a photo in landscape, and pinch to zoom in or out. 

The included Photos app also allows students to play slideshows that include music 
and transitions—a great way for students to showcase completed projects. Similarly, 
teachers can support visual learners by creating slideshows of text and images to 
enhance a vocabulary lesson, share math facts, support a history lesson, and more. 

Students can also collaborate on projects by emailing photos to one another and saving 
those images to the Photos app on iPad or iPod touch. These saved images can then be 
synced back to their iPhoto libraries for use in other applications. 

To open the Photos app:

n	 Tap Photos on the Home screen.

Videos

iPad and iPod touch allow you to view full motion video downloaded from iTunes, 
including free education movies in iTunes U, feature films, TV shows, video podcasts, 
and instructional media. Also, both devices integrate seamlessly with iMovie, so student 
productions can be viewed on the go.

To open the Videos app:

n	 Tap Videos on the Home screen.
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Notes

Notes provides students with a portable tool for capturing and sharing text that they 
can use in any number of ways. With Notes, students can easily add, read, and revise 
notes that appear onscreen on a yellow notepad. If your iPad or iPod touch is set up 
for email, students can also email notes that they’ve created, making it possible to 
collaborate with other students. Notes can be used for to-do lists, for taking notes as 
students work on collaborative projects, at group meetings and field trips, and more. 
And because you can copy and paste text with iPad and iPod touch, you can copy text 
from a web page or an email and add it to a note.

To open the Notes app:

n	 Tap Notes on the Home screen.

To take notes:

1	 To add a note, tap Notes, then tap the Plus Sign (+). 

2	 When you are finished typing the note with the keyboard, tap Done. 

3	 Tap the envelope button at the bottom of the screen to email your note. 

4	 Tap Notes at the upper left of the screen to view all of your notes. 

Calendar

Students can keep track of homework and manage tasks with the Calendar app on 
the iPad and iPod touch. Students can add events, set homework reminder alerts, and 
more. Teachers can create calendars in iCal for students to subscribe to, an easy way 
to communicate important dates and deadlines. Calendar looks like a typical calendar 
with month and day views, but like iCal on the Mac, it supports color-coded categories. 
This enables students to have a different color-coded calendar for each class, all 
accessed through Calendar. 

Students with organizational difficulties will find Calendar extremely helpful because 
they can use it to quickly organize a wide variety of data in one place. In addition, 
Calendar syncs with iCal on the student’s Mac, making it simple for students to manage 
a single calendar and keep it up to date.

To open the Calendar app:

n	 Tap Calendar on the Home screen.

Safari

With Safari, if the iPad or iPod touch is connected to a Wi-Fi network, you and your 
students can browse websites and search for information on the Internet, including 
Google searches. With both devices, students can do research both in and outside of 
the classroom and can have up to eight web pages open at a time. Files in PDF format 
can be downloaded and viewed on iPad or iPod touch as well.

You can also add bookmarks and sync them to iPad or iPod touch from a computer. This 
is particularly helpful if you want to provide students with a group of websites to use 
for research or if you have students who have difficulty searching or navigating the web 
browser on their own. With Safari, students can have up to eight pages open at a time, 
making it easy for them to compare information on a subject from multiple sources. 
This can help them learn how to evaluate information presented on the Internet. 
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Websites can be viewed in either portrait or landscape orientation—you just rotate 
either device to change the orientation. It’s easy to scroll around web pages or to zoom 
in and out on a page. Safari automatically fits the web page column to the screen for 
easy reading. Zoom functionality is especially helpful for students who need to see 
larger text and images.

To open Safari:

n	 Tap Safari on the Home screen.

To zoom in and out on a web page:

n	 Double-tap or pinch to zoom in and out. 

Using Additional Applications Included with iPod touch
The iPod touch includes a few additional applications that provide further benefits in 
and out of the classroom. 

Calculator

iPod touch includes Calculator—simply tap the onscreen buttons to enter figures 
and perform calculations. Calculator makes it easy for students to keep track of their 
calculations—when you tap the add, subtract, multiply, or divide button, a white ring 
appears around that button to indicate what operation is selected. When you rotate the 
iPod touch, it changes to a fully functional scientific calculator with dozens of functions. 
Thus, students no longer need to carry a separate scientific calculator. 

To open the Calculator app:

n	 Tap Calculator on the iPod touch Home screen.

Voice Memos and Audio Recording

You and your students can record memos, lectures, interviews, and conversations 
in full stereo on an iPod touch. Audio files can be reviewed later on iPod touch by 
using headphones or the built-in speaker. When you connect your iPod touch to your 
Mac, the audio recordings are copied to iTunes. The recorded audio files can then 
be reviewed in iTunes, edited in GarageBand, and used in other projects, such as for 
narration in a podcast created in GarageBand or an iMovie movie project.

How you produce a voice recording varies somewhat depending on the model of iPod 
touch and the software version that’s installed on the device. To record, you use a voice 
recording application and Apple earphones with a built-in microphone or a third-party 
microphone. A voice recording application, called Voice Memos, is included with each 
second-generation iPod touch that has version 3.0 software installed (sold separately). 
Otherwise, you can download an inexpensive third-party voice recording application 
from the App Store. With each iPod touch model and software version, you connect 
the Apple earphones with a built-in microphone or the third-party microphone to iPod 
touch, open the voice recording app, and start recording.
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The possibilities are endless—students can share personal notes, capture field trip 
notes, track small group discussions, or conduct interviews to use in a documentary 
film or podcast. Reading samples can be captured for assessment purposes or for 
students to use for self-reflection. Students learning a foreign language can record 
themselves to practice speaking and fluency. You can use iPod touch to dictate 
instructions for science labs, lesson plans, and research notes, or to record to-do lists as 
you think of them. Voice recording on iPod touch can also be used for recording staff 
or parent meetings instead of transcribing them. You can share what was recorded by 
posting the audio file on a website.

The voice recording capability of iPod touch can be used in a variety of ways:

•	 Students can record themselves reading, which allows them to play back what they’ve 
read and do self-evaluations, building to self-corrections. 

•	 Students can make recordings of books for younger children to use to read along, 
giving themselves reinforcement of reading skills and engaging them in reading for a 
real audience.

•	 Teachers can record lectures that students can review, which is especially useful for 
auditory learners and those who have difficulties with note-taking. 

•	 Students can trim a recording right on the iPod touch, so they can keep only the 
portion they need. 

•	 Students can organize their memos by choosing labels from a predefined list or by 
creating custom labels. 

To open the Voice Memos app (on models and software versions that include it):

n	 Tap Voice Memos on the iPod touch Home screen.

To use Voice Memos:

1	 Tap the red Record button to begin recording.

2	 Tap the Stop button on the bottom right to stop recording.

3	 Tap the “Go to voice memos” button (with the horizontal lines) at the bottom right to 
hear your recording.

To learn more about microphones and other iPod touch accessories, go to  
www.apple.com/ipod/accessories.

Accessing Information with Web Apps
Many web applications (web apps) are now available that are specially designed to  
take advantage of the Multi-Touch display on the iPad, iPod touch, and the iPhone.  
For example, when connected to a Wi-Fi network, you and your students can use web 
apps to do the following:

•	 Check out the latest news from a variety of news sources:  
http://getnews.mine.nu

•	 See what happened on this day in history: 
www.mymobilewebapps.com/history

•	 Read education headline news: 
http://site-press.com/educationnews

•	 Catch up on economic stimulus articles: 
http://site-press.com/stimuluspackage

http://www.apple.com/ipod/accessories
http://getnews.mine.nu
http://www.mymobilewebapps.com/history
http://site-press.com/educationnews
http://site-press.com/stimuluspackage
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As with other websites, you visit these websites by typing their URLs in the Safari 
address bar or by adding a bookmark to each. To browse through the more than 4000 
web apps now available, go to www.apple.com/webapps. The description of each web 
app includes a link to that page.

Using iPad or iPod touch to Address Visual Needs
Both the iPad and iPod touch include a screen reader and other innovative accessibility 
features that make it easier for those with limited vision to use.

VoiceOver

The same VoiceOver screen reader made popular on the Mac and the iPhone is 
now a standard feature on iPod touch 32GB and 64GB (Fall 2009) as well as the iPad. 
VoiceOver is the world’s first gesture-based screen reader, enabling students to enjoy 
the fun and simplicity of these devices even if they can’t see the screen.

You control VoiceOver using simple gestures that let you physically interact with items 
on the screen. With VoiceOver, you simply touch the screen to hear a description of the 
item under your finger, then gesture with a double-tap, drag, or flick.

Traditional screen readers describe individual elements on the screen but struggle to 
communicate where each element is located or provide information about adjoining 
objects. This contextual information is very important but typically filtered out by other 
screen readers. For example, “off-screen” models used by traditional screen readers to 
represent applications and web pages intentionally strip away contextual information 
and describe web pages as a list or menu of items. VoiceOver on iPad or iPod touch is 
different from these types of screen readers.

Because VoiceOver works with the touchscreen, you interact directly with objects on 
the screen and can understand an object’s location and context. When you touch the 
upper-left corner of the screen, you hear what’s in the upper-left corner of a web page. 
As you drag a finger around the screen, you learn what’s nearby, providing a sense 
of context and relationships between the items you hear. You can hear descriptions 
of every item, including status information such as battery level, Wi-Fi signal levels, 
and time of day. iPad and iPod touch even let you know when the display changes to 
landscape or portrait and when the screen is locked or unlocked.

The speaking rate is adjustable so it can be set to a speed that best suits a student’s 
listening ability. VoiceOver uses distinctive sound effects to alert you when an 
application opens, when the screen is updated, when a message dialog appears, 
and more. When VoiceOver is talking, the volume of background sounds and music 
is automatically lowered, “ducking” under the voice, so you can clearly hear what 
VoiceOver is telling you.

To watch a video about VoiceOver, go to www.apple.com/iphone/iphone-3gs/
accessibility.html#video.

VoiceOver includes built-in voices that speak over 21 languages including Bahasa 
Indonesian, Chinese (Cantonese), Chinese (China), Chinese (Taiwan), Dutch, English 
(U.S.), English (UK), English (Australian), Finnish, French (Canada), French (France), 
German, Greek, Italian, Japanese, Korean, Norwegian, Polish, Portuguese (Brazil), 
Portuguese (Portugal), Romanian, Russian, Slovak, Spanish (Mexico), Spanish (Spain), 
Swedish, Thai, and Turkish.

http://www.apple.com/webapps
http://www.apple.com/iphone/iphone-3gs/accessibility.html#video
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Getting Started

VoiceOver is built into the 32GB and 64GB iPod touch (third generation) and the 
iPad. All you need is iPod touch, an iPad, or iTunes 9 or later, and a Mac or PC. You 
can activate and enable VoiceOver without sighted assistance using iTunes with a 
compatible screen reader like VoiceOver (included in Mac OS X). When you activate the 
iPad or iPod touch using iTunes, you can enable VoiceOver to start using it right away. 
Or a sighted user can enable VoiceOver for you directly on the device by using the 
Settings app. 

VoiceOver works with all of the built-in applications that come with the iPad or iPod 
touch, such as Music, iTunes, Mail, Safari, and Maps. So students can surf the web, email 
their friends, check the weather, and much more. 

To turn on VoiceOver on an iPad or iPod touch:

1	 Tap Settings on the Home screen. 

2	 Choose General > Accessibility > VoiceOver.

3	 Tap the VoiceOver On/Off switch to turn on VoiceOver.

Note: VoiceOver changes the gestures used to control the iPad and iPod touch 
(as described below).

The following sections provide an overview of VoiceOver on iPad and iPod touch. For 
more information and instructions, see the iPad User Guide and the iPod touch User 
Guide, available at www.apple.com/support/manuals.

How It Works

With VoiceOver enabled, you use a different but simple set of gestures to control the 
device. For example, instead of tapping to activate a button, you tap the button to hear 
a description of it, double-tap to activate it, and swipe up or down to adjust a slider.

When an item on the screen is selected, a black rectangle called the VoiceOver cursor 
appears around it. The VoiceOver cursor is displayed for the benefit of sighted users 
with whom students may be sharing the iPad or iPod touch. When a student prefers 
privacy, VoiceOver includes a screen curtain that turns off the display so no one can 
read it without his or her knowledge. 

In addition to touching and dragging around the screen, you can also flick left and 
right to move the VoiceOver cursor precisely to the next or previous item on the 
screen—no matter how big or small it is. 

VoiceOver features an innovative virtual control called a “rotor.” Turning the rotor—by 
rotating two fingers on the screen as if you were turning an actual dial—changes 
the way VoiceOver moves through a document based on a setting you choose. For 
example, a flick up or down might move through text word by word. But when you 
choose the “character” setting, each time you flick up or down, VoiceOver moves 
through the text character by character—perfect when a student proofreads or edits 
text.

Practice Gestures

With the Practice Gestures setting on iPad and iPod touch, you can hone your 
technique and learn new gestures or find out what each gesture does.

http://www.apple.com/support/manuals
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To practice VoiceOver gestures:

1	 Tap Settings on the Home screen. 

2	 Choose General > Accessibility > VoiceOver > Practice Gestures. 

3	 Tap the Practice VoiceOver Gestures button.

As you practice flicks, taps, and so on, the device tells you what that gesture will 
accomplish. The screen will not display anything.

Entering and Editing Text

As text is typed, such as an email message or a note, VoiceOver echoes each character 
on the keyboard as it is touched and again to confirm when it is entered. To help a 
student type more quickly and accurately, both iPad and iPod touch feature word 
prediction and suggest the correct spelling when he or she types a word incorrectly. 
Cut, copy, and paste options are also available with VoiceOver.

Zoom

While many iPad and iPod touch applications let users zoom in and out on specific 
elements, such as images in Mail or web page columns in Safari, Zoom lets you  
magnify the entire screen, including the Home, Unlock, and Spotlight screens as well  
as the screens of any application. Zoom can be enabled on the iPad and the 32GB  
and 64GB models of the iPod touch (third generation) using iTunes when you’re  
setting up your device for yourself or someone else or can be set up from either  
device in the Settings app. 

To turn on or turn off Zoom on an iPad or iPod touch:

n	 In Settings, choose General > Accessibility and tap the Zoom On/Off switch.

A double-tap with three fingers instantly zooms in and out 200%, and you can double-
tap and drag three fingers to adjust the magnification between 100% and 500%. Even 
when the screen is zoomed, you can continue using all of the familiar flick, pinch, tap, 
and other gestures to run your favorite applications. Zoom can also be used with White 
on Black (reverse video) and Speak Auto-text.

White on Black

For those who need or prefer higher contrast, iPad and applicable iPod touch models 
provide an option to change the display to White on Black. This reverse video effect 
works in all applications, including the Home, Unlock, and Spotlight screens, and can be 
used with Zoom and VoiceOver.

To invert the colors:

n	 In Settings, choose General > Accessibility and tap the White on Black switch.

Triple-click Home

With the Triple-click Home feature, you can set up iPad and applicable iPod touch 
models so that pressing the Home button three times quickly toggles VoiceOver on or 
off; toggles White on Black on or Off; or presents you with the option to turn VoiceOver, 
Zoom, or White on Black on or off.

To set up Triple-click Home:

n	 In Settings, choose General > Accessibility > Triple-click Home and choose the function 
you want.
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Speak Auto-text

As you type, iPad and iPod touch suggests a word before you finish typing it or a 
correction when a word is misspelled. Speak Auto-text speaks these suggestions so 
you can hear them when they’re presented. When the screen is zoomed, for example, 
the suggestion might not be visible, but you can hear and accept it without seeing it. 
If students are using VoiceOver, they won’t have to interrupt their typing and touch 
the suggestion to hear it. Speak Auto-text can be enabled even when you’re not using 
VoiceOver or Zoom.

To turn Speak Auto-text on or off: 

n	 In Settings, choose General > Accessibility and tap the Speak Auto-text switch.

Tactile Buttons

Both iPad and iPod touch include a few, easily discernible physical buttons used to 
control them: the Sleep/Wake button, located on the top edge; the volume control 
buttons, located on the upper-right edge on an iPad and the upper-left edge on an 
iPod touch; and the Home button, centered below the display.

Giant Fonts for Mail Messages

For improved email readability, you can increase the font size of email text from 
Medium (the default) to Large, Extra Large, or Giant.

To change the Mail font size:

n	 In Settings, choose Mail, Contacts, Calendars > Minimum Font Size and choose the font 
size you want to use. 

iPad and iPod touch Earphones

The new 32GB and 64GB iPod touch models and iPad models come with a stereo 
headset with a high-performance microphone built into the cable. Plug the headset 
into the standard 3.5-mm stereo headphone jack and control music playback by 
clicking the remote button. 

Using iPad or iPod touch to Assist Learners with  
Auditory Needs
iTunes, paired with the iPad or iPod touch, include features designed to assist those 
who are deaf or hard-of-hearing.

Captioned Movies on iPad or iPod touch

Both iPad and iPod touch can display captions when present in the content. Captions 
appear in a high-contrast white-on-black font that’s easy to read.

Students can find captioned content in the iTunes Store where they can purchase or 
rent closed captioned movies. In addition, students can find captioned podcasts on 
iTunes U, such as those in The American Experience series produced by WGBH Boston. 
Because iTunes U and the iTunes Store continually add captioned content, they’ll want 
to visit often to check for new content. Students can also access this content directly 
on iPad or iPod touch using the iTunes app and a Wi-Fi connection. 
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iPad and iPod Standard Audio Out Jack

With the industry-standard 3.5-mm stereo headphone jack, students can connect a 
wide variety of headphones and externally amplified audio speakers to all iPad and 
iPod models to suit their needs.

Password-Protected Volume Limit Controls

To help prevent hearing loss that may occur when listening to audio at high volume 
over long periods of time through earphones, all currently available iPad and iPod 
models include volume limit controls, allowing you to easily set the maximum listening 
volume. You can protect the maximum volume with a password, so it cannot be 
changed without permission.

Mono Audio

A student with limited hearing in one ear can tap a checkbox to route both right- and 
left-channel audio into both earbuds to hear both channels in either ear. 

To set up Mono Audio:

n	 In Settings, choose General > Accessibility > Mono Audio and tap the Mono Audio 
On/Off switch.

Accessibility Add-Ons for iPad and iPod touch

Several add-on products are also available for iPad and iPod touch that can help those 
with hearing disabilities, including a hearing aid-compatible induction ear loop from 
TecEar, a wireless remote headset from Oticon, and others. 

Using Third-Party Apps to Support Learning
A variety of third-party apps are available through the App Store that will assist diverse 
learners in many different ways. Here are some examples:

Dictionary.com—Free by Dictionary.com

The Dictionary.com app delivers content from Dictionary.com and Thesaurus.com, 
including more than 275,000 definitions and 80,000 synonyms. Once the app is 
downloaded onto the device, an Internet connection is not needed to use it. Students 
start typing a word, and Dictionary.com offers a list of words beginning with those 
letters, making it easy to locate the word and definition. With the tap of a finger, 
students can toggle between the dictionary and thesaurus entries for a particular 
word. Students with reading difficulties and English language learners will appreciate 
being able to easily locate unfamiliar words. Meanwhile, students looking to build their 
vocabularies will appreciate the “Word of the Day” area, which highlights a different 
word each day. 
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iHomework—Free by Paul Pilone

iHomework helps students keep their school work and life organized. Using the 
application, students can track assignments, store class and teacher information, 
calculate course grades, and set reminders for everything they need to do. iHomework 
captures information for every assignment including the title, type of assignment 
(test, project, paper, and so on), due date, course the assignment is for, grade, and any 
notes students want to capture about the homework. Once entered, students can 
view assignments by day, week, or the course to which they are related. Completed 
assignments are kept in a separate list, allowing students to see what they’ve 
accomplished without cluttering their current assignments. iHomework is customizable; 
students can color-code and organize items based on their individual needs. Students 
with organizational difficulties will find that using iHomework can help them improve 
their classroom performance.

soundAMP—$9.99 by Ginger Labs

soundAMP is a hearing amplifier for the iPod touch. Used along with a headset with 
mic, it is designed to help anyone who needs a hearing boost, whether they are in a 
classroom, sitting in the back row of a presentation, or talking with family and friends. 
soundAMP’s processor manages sound levels for the user, amplifying soft and medium 
sounds and softening loud sounds, providing clarity at all volume levels with limited 
distortion. A student uses earbuds with soundAMP. The touch screen lets students 
adjust the volume and tone to their liking and the repeat button enables users to 
replay what was just said.

Sign 4 Me—$9.99 by Vcom3D

Sign 4 Me helps students learn American Sign Language, and it can help hearing 
students communicate with deaf or hard-of-hearing classmates. Type a word or phrase, 
and Sign 4 Me translates that word or phrase into sign language, using a signing avatar. 
The avatars are 3D and can be zoomed in or out and rotated to give students the best 
vantage point for every sign. With 11,500 words in the library, Sign 4 Me is perfect for 
sign language beginners and anyone hoping to improve communication with the deaf 
community. 

Proloquo2Go—$189.99 by AssistiveWare

Prologquo2Go provides a full-featured augmentative and alternative communication 
solution for people who have difficulty speaking. It can be used with children and 
adults with autism, cerebral palsy, Down syndrome, developmental disabilities, apraxia, 
ALS, stroke, or traumatic brain injury. It provides natural sounding text-to-speech 
voices, up-to-date symbols, powerful automatic conjugations, and a default vocabulary 
of more than 7000 items. It turns the iPad and the iPod touch into powerful tools for 
anyone needing an alternative communication solution.

There are also a multitude of applications to assist students with accessibility needs, 
including apps for augmentative and alternative communication, sound augmentation, 
American Sign Language, early childhood development, English language learners, and 
more. Visit the App Store for a full list of educational apps. 
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Enhancing Classroom Learning with iPad or iPod touch  
and iTunes
There is no shortage of ways you can use iPad or iPod touch and iTunes to support 
teaching and learning. This section provides some example ideas for their use in the 
classroom.

Supporting Language Acquisition

iPad and iPod touch offer a wide array of engaging ways to assist students as they gain 
language skills. Students of all ages can benefit from the many language acquisition 
apps and resources available from the App Store and the iTunes Store. For example, 
younger students can have fun while learning grammar and letter sounds with 
animated apps while high school students can gain vocabulary expertise for college 
entrance exams. Students can use these devices to review flash cards for vocabulary  
in a book they are reading or for sight words for early readers, with the flash cards 
either ready-made or created by you or your students.

Students who are learning a world language can download apps from the Apple App 
Store to practice the language or look up words with translator apps. Using resources 
available on iTunes U and the iTunes Store, they can listen to audio recordings, such as 
the news in Spanish, and watch videos to learn words and phrases, hearing the proper 
pronunciations. They can also record themselves using iPod touch or GarageBand 
to practice the language and improve their fluency. Using the lyrics and album art 
information in each audio file can further reinforce the learning of another language. 
For example, if the text of what a student is listening to is pasted into the Lyrics portion 
of the audio file, students can see and hear the content.

Building Reading Fluency

Struggling readers often do not know what they would sound like as a fluent reader. 
You can use iPod touch or GarageBand to record students as they read a passage, 
then edit the recording in GarageBand by eliminating pauses and miscues so that the 
student sounds as fluent as possible. Send the edited recording to iTunes and sync with 
an iPad or iPod touch. The student can listen to himself or herself reading naturally—
that recording then becomes the bar the student strives for when reading aloud.

Staying Organized

All students, and particularly those who have difficulty with organization, will find 
many valuable tools included with iPad or iPod touch. They can use the Calendar 
application and write notes to themselves to keep up with due dates. You can send 
email to specific students with information, reminders about classwork, and PDF files 
of assignments. Students can also use the Clock application, included with iPod touch 
(not standard on iPad), to set alarms for themselves to stay on track, and download 
additional apps from the App Store to help organize their time.
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Motivating Readers with Audiobooks

Audiobooks can be downloaded for use on iPad or iPod touch, or older students can 
use voice recording with iPad and iPod touch or GarageBand to narrate and record 
books for younger students to listen to. Younger students can read along using the 
book as they listen. Students can pause as they’re listening to an audiobook to take 
notes with the Notes application or use the Internet when they have a question about 
something in the book. They can also read the text of the book on iPad or iPod touch 
as they listen. Some teachers find it helpful to have hesitant or struggling readers listen 
to the first chapter of a book on iPad or iPod touch so they can get “hooked” on the 
book, and then have them read the rest of the book on their own.

Where in the World

You can enrich curriculum in many subject areas with the use of Google Maps, 
included with iPod touch, and Google Earth, available from the App Store at no cost. 
Students can find famous locales, sites referred to in literature, or explore locales to set 
their own stories or scripts. They can use Google Maps and Google Earth to develop 
a presentation about historical buildings or locations in their community, switching 
between views to learn more. They can then use iPad or iPod touch to take notes, 
view photos, and look up more information on the Internet—and then share the 
presentation with others via iTunes.

Many other applications can be downloaded to support students’ global studies, such 
as reference apps about the world’s countries and historical games.

Mobile Math

No matter what their level of math, students will enjoy math learning with iPad 
and iPod touch. They can reinforce their math skills with engaging, interactive apps 
downloaded from the App Store to learn about fractions, review algebra, study for 
college entrance exams, and more. iTunes U also offers many math-related resources 
to enrich your lessons—for example, students can explore the relationships between 
math and music, nature, and art, watch math videos, or play challenging math games. 
They can also perform calculations and check their work with the iPod touch built-in 
Calculator, which includes a scientific calculator, and by downloading the graphing 
calculator available from the App Store for the iPad or iPod touch. You can extend 
your classroom teaching of math by making a video of yourself introducing a new 
mathematical concept—students can then download that video to iPad or iPod touch 
and review it as many times as they need to reach a full understanding of the topic.

Astronomy to Zoology

iPad and iPod touch can enrich teaching and learning of science at all grade levels. In 
lab classes, students can access experiment instructions that can include narration, text, 
video and photos. Students can then use iPad or iPod touch to collect data with the 
Notes application. Using the Clock application on an iPod touch, or a similar clock app 
downloaded from the App Store for the iPad, they can time data collection. And they 
can compare their results with images from similar experiments on the Internet, and 
share their data with other students via email.

A broad array of valuable science resources is available for use with iPad or iPod 
touch through the iTunes Store. You can browse the Science category of iTunes U 
to find content for students, from examples of bird songs to talks on physics and 
nanotechnology. Applications that can be downloaded for iPad and iPod touch include 
a clinometer to measure slopes; a seismometer to measure the earth’s vibrations; or 
movies, periodic tables, a science quiz app, and astronomy apps for observing the sky.
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Using iPod touch for Assessment
Oral language sampling is one way to evaluate the language of students with a hearing 
loss or any language delay. A voice recording is often a more accurate indicator of the 
communication ability of a student than evidence obtained through formal tests, and 
the recordings can be used year after year to track student progress. You can make 
recordings of a student with iPod touch and then import them into iTunes to save in 
the student’s audio playlist. You can then use iPod touch or iTunes to easily move to 
any point in the sample to review the student speech. These samples can also readily 
be shared with parents or a student study team. Using an iPod and iTunes for capturing 
and storing these voice recordings greatly simplifies the process.
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Connecting Learner Needs with 
the Built-in Tools on a Mac
Today’s increasingly diverse student population requires 
educators to seek solutions that engage and support learners 
regardless of ability, disability, background, or learning style. 
With Apple products, educators have the power to provide a 
customized learning environment for any student. 

The following vignettes provide examples of how you can use the features on Apple 
products, including the Mac, iPad, and iPod touch, to provide learning opportunities 
for everyone in the classroom—leveraging strengths and bypassing or alleviating 
challenges, so that learning differences can be addressed. Each vignette highlights a 
student with a different array of strengths and struggles and presents specific ideas 
for how that student’s needs can be addressed with the tools described earlier in this 
guide. While no two students are alike, these vignettes can provide models that you 
can modify to meet the specific needs of your students.

Helping Students Get Organized and Stay on Task 
Many students who need help with task management and organization would do just 
fine in school if they had an administrative assistant, like many business executives 
have. For these students, technology can provide backup support for some of those 
“executive-functioning” roles. Teachers and students can use Apple’s built-in technology 
features and applications to develop students’ task management and organizational 
skills. 

Student Profile: Brian

Brian struggles with organizing his work on paper. Although he understands advanced 
science concepts, he has difficulty taking organized notes on what is presented in class 
as well as explaining his lab results in writing. He complains that he can’t remember 
all the details, that he feels like his brain is running out of space. He also has trouble 
keeping track of his homework, often forgetting what the assignment is or losing it 
before it is submitted or turning it in late. 

To help with his note-taking, Brian and his math partner, Max, share responsibility for 
typing class notes with a word-processing application, such as TextEdit or Pages. Brian 
frequently uses iChat to send files to and receive them from Max and to make sure his 
notes have the key points. With iChat text chats, Brian can communicate with other 
students while building his writing skills.
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iMovie projects and audio podcasts give Brian an ideal way to express and share his 
understanding of science concepts. For instance, instead of writing out his solution on 
paper, Brian produces short movies with iMovie or podcasts recorded with GarageBand 
to demonstrate that week’s lab results. He adds these files to the class science blog 
created with iWeb.

For Brian, the key to managing his time and organizing his work is making use of the 
tools that bypass or strengthen his weaknesses. He subscribes to the class calendar in 
iCal so he knows what his assignments are and when they are due. He also uses the 
iCal To Do lists and alarms with his iCal calendar to help him keep on track. In addition 
to iCal, Brian has made the Countdown Plus widget an essential part of his routine, so 
that he know exactly how much time he has left for in-class assignments and long-
term projects.

Brian also syncs his iCal calendars to his iPad, and uses third-party apps such as 
iHomework to help him stay on top of assignments for each of his courses. He likes 
that iHomework lets him categorize the type of assignment so he can know to leave 
more time for papers. It’s also helpful that iHomework organizes homework entries by 
day, week, and course so he can see things not only for that day or week but also all 
upcoming assignments for an individual class. Brian also uses iHomework to track his 
grades and keep track of the assignments he has completed so he can see his progress. 

Brian’s teacher uses iWeb to post homework assignments on a class website, so Brian 
and his parents can both make sure he has everything that’s needed. Brian submits 
written work from home via email as soon as he completes it to better ensure that it 
will be handed in on time. To make it easier to locate and keep track of his work on the 
computer, Brian has organized a folder for each month’s work for each subject in the 
Documents folder. If he still has trouble locating a document or an image file, he knows 
he can quickly find it using Spotlight, a search application built into Mac OS X.
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Supporting English Language Learners 
In many classrooms across the country, teachers are working hard to support English 
language learners, as well as other students whose receptive and expressive language 
skills are not strong, even though English is their native language. Technology offers a 
variety of ways to compensate for language weaknesses as well as to strengthen those 
areas of need. 

Student Profile: Alicia

Alicia, an English language learner, struggles with speaking in English. Although her 
vocabulary is good and she finds it easy to memorize grammar rules and verb tenses, 
she finds it difficult to carry on a full conversation in English. She becomes an introvert 
in class to avoid being teased for her speaking ability. Her schoolwork is beginning to 
suffer as she becomes frustrated at not mastering English as quickly as some of her 
classmates. She is animated when speaking in Spanish, however, and is a good writer in 
Spanish.

One way Alicia’s teacher has her build her spoken English skills is by using GarageBand 
on the Mac and Voice Memos on the iPod touch to record herself reading; she practices 
verbal fluency a number of times with the same passage. She saves these recordings in 
iTunes so she and her teacher can see her improvement and takes them home on her 
iPod touch to share with her family. 

When she is writing in English, Alicia consults the Dictionary application on her 
Mac or iPod touch and uses the text-to-speech functionality of the Mac to hear the 
pronunciation of words with which she is unfamiliar. She also uses text-to-speech to 
hear web pages and other documents read aloud as she reads along. Alicia frequently 
checks the Translator widget to make sure she is using the correct English word. She 
has an English-Spanish dictionary on her iPod touch to help her with unfamiliar words 
and phrases. She sometimes uses International preferences in System Preferences to 
view the computer’s menus and other onscreen elements in Spanish. Her teacher has 
suggested to Alicia that she complete some of her writing projects in Spanish, which 
has bolstered her self-esteem.

Because Alicia is an expert native Spanish speaker, her teacher has Alicia act as a 
partner to write and record dialogues in Voice Memos for other students to hear 
Spanish from a native speaker. Alicia’s teacher also has her create vocabulary books in 
iPhoto for her classmates to use to practice their Spanish. This helps Alicia maintain 
her heritage language proficiency and use her writing skills, while building her English 
skills. She has become more confident when she speaks in front of the class since the 
teacher has asked her to introduce the dialogue exercises and vocabulary books. 
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Addressing Communication and Social Needs
Sometimes a student’s social struggles are more significant than academic issues. For 
students who fear raising their hands and speaking in class, technology tools provide 
the privacy needed to express learning without fear of humiliation. Technology also 
gives such students a way to demonstrate what they’ve learned to the whole class 
without having the focus be on them. For example, sharing a movie or slideshow 
students created can help diffuse some of the attention on the speaker. 

Student Profile: Steve

Steve is a loner and feels isolated from his schoolmates. Mostly withdrawn in class, 
he hates being called on and misses school whenever he can. He also struggles with 
written language—mostly spelling and grammar. He has wonderful ideas but fear 
of spelling mistakes means he uses words that are simpler than the ideas he has to 
express. He reads slowly, but understands and remembers everything he studies. Steve 
is creative; his teacher knows that he writes and plays music out of school and loves to 
draw. 

To strengthen his written work, Steve uses TextEdit with its spelling checker and word 
completion feature to give him suggestions for how to spell words. He uses text-to-
speech to hear his work read back to him and check for grammar mistakes. He also 
uses the built-in Dictionary on the Mac and the Dictionary.com app on his iPad to look 
up words, which is much easier and faster than looking up words in the hard-copy 
dictionary. Using the thesaurus in both Dictionary on the Mac and Dictionary.com on 
the iPad helps him build his vocabulary.

Steve’s engagement with the class has improved immeasurably since his teachers have 
encouraged him to use his artistic gifts to demonstrate what he has learned. He uses 
GarageBand to compose and record songs that express the themes of the novels the 
class is reading; these compositions are then used as background music for slideshows 
the class produces about the novels with iPhoto. 

In history, he produces documentaries and video podcasts with iMovie as an alternative 
to research papers. These productions are the envy of his classmates. He combines 
scanned images of his artwork with photos and video clips he’s taken, and then he 
adds music that he records in GarageBand. Script writing comes easily to him and has 
improved his writing skills. In addition to sharing the movies and podcasts with the 
class, the teacher uses iWeb to post them on a class website so that Steve can share 
them with his family. 
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Addressing Memory and Attention Problems 
For many students, trying to keep up with all the information that is presented in class 
is like trying to do a thousand-piece puzzle on a tabletop that is too small—like pieces 
that keep falling off the edge, information just seems to slip away. When the stress of 
falling behind gets too great, some students tune out or shut down, almost like an 
overloaded circuit breaker. Computers offer students a place to store what they need to 
remember and retrieve it when it is needed. 

Student Profile: Jeff

Jeff has a hard time maintaining his focus in his algebra class. Mastering math is 
complicated by his difficulties with memory and attention. Jeff can concentrate on 
puzzles and video games for hours, but finds it almost impossible to follow the steps as 
his teacher writes them on the board. He says his teacher goes too fast for him to grasp 
the big ideas; he is still trying to understand the steps in factoring polynomials while 
his teacher has gone on to graphing and interpreting equations. Sometimes he just 
tunes out the class altogether, figuring he’ll never catch up. 

Jeff’s teacher uses iMovie and GarageBand to create movies and podcasts that present 
the steps in solving problems. Jeff reviews these at home to help him remember what 
was said. Knowing that he can listen to and watch the lectures at home and replay 
them as often as he wants relieves the pressure of trying to understand and take notes 
at the same time.

When he does his math homework, Jeff enters data with Calculator and has the 
computer read aloud both the numbers he enters and the results. Using technology 
helps Jeff maintain his attention and takes some of the drudgery out of computation. 
He also likes to use the Calculator application on his iPod touch as another tool to help 
him with his attention span. Tapping the iPod touch screen provides him with an even 
more interactive experience than the computer.

For an end-of-unit project, Jeff works in a small group to create a movie study guide. 
Jeff’s group uses Grapher to produce short animations to show how numbers relate 
to each other with two- and three-dimensional graphs. They export those animations 
to the group’s iMovie project where they add text, additional images, and narration 
to explain each equation. Jeff is a valued member of the group, and finds that making 
movies is so exciting for him that he can focus on creating the animations and editing 
the movie for long periods of time. 
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Increasing Literacy Skills
Students who struggle with any of the communication skills have difficulty letting 
their teachers know how much they’ve learned as well as with understanding what is 
presented, even if they have no difficulty understanding big ideas. Technology tools can 
help students develop their literacy skills while gaining understanding and letting their 
teachers see their mastery. 

Student Profile: Lindsey

Although she’s a gifted photographer and has excellent math skills, Lindsey reads 
below grade level, and she sometimes has trouble understanding what she’s read. She 
reads very slowly, and it’s hard for her to sort out what is the most important point and 
what are the details. She finds it difficult to express herself verbally and so avoids being 
called on when students take turns reading in class. 

Lindsey’s teacher makes sure that some of the novels the class reads are available to 
download from the iTunes Store. In this way, while Lindsey is reading the book, she can 
also hear the text read aloud on a computer with iTunes or on an iPod or iPod touch.

For short reading assignments, Lindsey’s teacher has her use her iPod touch and 
microphone to record herself reading a story. She then posts these audio files as well 
as text files of the story to a shared folder on a server so that students can review 
them from any computer on the school network. Lindsey opens the text files with 
TextEdit and uses the Summarize feature to help her understand the key points of 
the assignment. While she listens to the audio files, she reads along to practice her 
decoding and build up her speed. 

When she uses the Internet, text-to-speech helps her understand the content and 
answer questions more quickly. She frequently checks the meaning of words using 
Dictionary on the Mac and hears entries read aloud. If she’s reading a book, she has her 
iPod touch handy so that she can look up unfamiliar words on a third-party app such 
as Dictionary.com.

Lindsey’s teacher has excused her from reading passages aloud in class for now; as an 
alternative, Lindsey uses Voice Memos and a mic on her iPod touch to record herself 
reading passages assigned by the teacher, who saves them for assessment. Since 
Lindsey has started doing this on a regular basis, she has acquired a greater facility 
with reading aloud. Lindsey then combines these recordings with photos she’s taken to 
produce iPhoto slideshows to share with the class about the book they are reading.
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Addressing	Physical	and	Motor	Difficulties
The Universal Access features built into the Mac are essential for students with physical 
disabilities, but they are also helpful for those who struggle with handwriting or those 
whose fine motor skills make the traditional use of the keyboard and mouse more 
difficult. 

Student Profile: Bodhi

Bodhi was born with cerebral palsy and has limited use of his left side. He reads at 
grade level and has many friends in the class. He also has a remarkable collection 
of jazz music that he keeps track of with iTunes. Having his music on his Mac makes 
it easy for him to play any selection he wants because his fine motor difficulty is 
addressed by the accessibility features of the computer. 

Bodhi has configured his computer with Universal Access settings so that operations 
that might be difficult with his physical limitations are accommodated. He controls the 
mouse with Mouse Keys keys and uses Sticky Keys to press modifier keys as a sequence 
and to eliminate the repeat key function. Bodhi has turned on Slow Keys to slow down 
the computer’s response when he presses a key, which has made him more relaxed at 
the keyboard. He uses Speech Recognition to minimize the motor sequences needed 
to operate the computer and navigate among applications. 

Bodhi enjoys collaborating with his classmates in video conferences using the built-in 
iSight camera on his MacBook and iChat. Bodhi’s class is working with classes in other 
regions of the United States to collect data on geography and climate. Bodhi uses the 
iChat recording features to save the content so he doesn’t have to worry about taking 
notes while he’s talking.

Bodhi’s teacher has assigned note-takers for each lecture who type the notes with 
TextEdit. Each student in the class is a note-taker at least once each semester. The 
teacher posts the notes on the class website she created with iWeb. In this way, Bodhi 
makes sure he gets the class notes since he’s not the fastest typist in the class. (Other 
students in the class also appreciate having the notes available on the Internet.) The 
class note-takers supplement their notes with photos or drawings of the diagrams the 
teacher uses in class. 

Bodhi is able to really show his talents when he collaborates on group iMovie movies 
and video podcasts that the teacher offers as alternatives to written assignments. Bodhi 
often acts as the producer—making sure that everyone is doing their part and helping 
to resolve any problems that come up within the group. He contributes his ideas for 
the scripts, records the narration for the podcasts, and contributes music from his 
collection for the soundtracks. 
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Supplementing Verbal Instruction with Visual Tools
Students with even mild hearing impairments may struggle in classrooms where 
teacher presentations and lectures dominate instruction. Other students may not 
process information effectively by listening, even though their hearing is just fine. 
Technology tools can help these students get the big ideas when teachers use a 
slideshow or movie to help students visualize the concept or skill. And when students 
are given an option to make a poster or capture video and create a movie with their 
narration, their mastery of ideas and processes becomes clearer.

Student Profile: Belinda

Belinda has loved to draw since she was little, and she has always amazed her family 
and friends with her ability to represent what she sees. She was slow to learn to talk, 
though, and speaking has always been a trial—it’s laborious and embarrassing for her 
to be called on to read in class. Her hearing loss was not diagnosed until she was in 
second grade. 

Her teacher can see Belinda’s engagement and understanding begin to blossom as 
long as Belinda is offered ways other than spoken words to express what she has 
learned. Belinda uses Keynote when she is asked to present to the class. She scans 
or takes photos of her drawings to include on the slides, and she feels more at ease 
speaking when she has Keynote presenter notes and the Presentation Display to 
accompany her slides. She also takes part in iChat text chats with her classmates, which 
allows her to discuss class projects readily.

Belinda’s class is learning how to use iMovie, and they use subtitles or the text track in 
QuickTime to caption their movies. The text track ensures that students with hearing 
losses don’t miss any of the action or meaning. Sometimes the teacher turns the sound 
off, so all students get to experience what life is like for people who are hard-of-hearing 
like Belinda. Belinda enjoys working on the class movie projects—she contributes her 
original artwork, captures video with a camcorder, and takes part in the editing process.

Belinda wears headphones when she’s using the computer so that she can freely 
adjust the volume settings and more readily focus without any noise distractions from 
the classroom. She also uses the Flash Screen feature in Universal Access Hearing 
preferences so that the computer flashes a visual alert, rather than playing a sound, 
when an onscreen alert appears. 
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Helping with Handwriting and Retention Problems
Some students who have a difficult time taking notes in class or writing out 
assignments or papers may find that using a keyboard is more efficient. As such 
students do research using the Internet, they can get note-taking support by using 
technology. They can use text-to-speech to listen to web pages if reading fluency, 
comprehension, and speed are also problems. Teachers can use word-processing 
software to create templates that have preformatted headings and tables to help 
organize assignments on paper, allowing students to focus more on the content of 
the work rather than on trying to remember just how to do it. This also alleviates the 
struggle some students have with manipulating pen and pencil. 

Student Profile: Rafael

Rafael is a star on the school tennis team; the coach finds him focused and dedicated. If 
it weren’t for sports, Rafael probably wouldn’t come to school at all. 

He is disciplined about his fitness and gifted athletically, but he struggles to remember 
what he’s read or learned in class. Even though his gross motor skills and coordination 
are first-rate, his fine-motor skills and handwriting are a huge problem. His coach has 
told him that even though he’s the number one player on the tennis team, he has to 
bring up his grades in history and English to be eligible to play.

To help with history, his teacher puts her lectures into podcasts that she creates with 
GarageBand and then imports into iTunes; she’s added some chants and music to help 
the memory challenges. Rafael downloads this material on an iPod and heads off for his 
daily five-mile run. The daily review has helped him feel more confident in class, and he 
seems to remember better when his feet are moving. 

Rafael is working on his keyboarding skills, and he finds that it’s much easier and 
faster to use a word-processing application to write his papers than to struggle with 
handwriting. When doing Internet research, he uses Safari and adds Sticky Notes 
available from the Services command to help him remember key points on web pages. 

Rafael likes being able to add pictures to his writing assignments. He takes a digital 
camera with him everywhere to look for images and real-life scenes to complement 
his compositions. He then uses Pages layouts to produce papers that combine his text 
with his photos. He’s proud to turn in such neat, organized, attractive papers. Suddenly, 
school’s become more interesting, and Rafael’s teachers see a real change in his 
motivation. 
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Helping Students with Visual Impairments Get the  
Big Picture
Just as some students have trouble in classrooms where they have to be terrific 
listeners, other classrooms may pose challenges for those with visual impairments. 
Fortunately, students can use the features on the Mac to make sure they get to hear 
what others see—which can be important for students with low or no vision. 

Student Profile: Shandra

Shandra is legally blind, but she can see very large print, especially if it’s white on 
black. She enjoys using the computer for her schoolwork and to create podcasts that 
combine music and narration. 

Shandra has worked with her teacher to set up her computer with Universal Access 
preferences to meet her needs. She has changed the display to white text on a black 
background. She knows how to use the Zoom option to enlarge whatever is on the 
screen, and she sets the size of icons and their text labels with the View menu so that 
they’re large enough for her to locate files without having to ask for help. She also 
has the time read aloud on the hour, which was set in the Clock pane of Date & Time 
preferences.

With VoiceOver, Shandra can work with a small group of students and hear what 
everyone else is seeing on the screen. It’s best for her to use the keyboard or Multi-
Touch trackpad to navigate instead of the mouse, and VoiceOver tells her exactly where 
she is and what the choices are for the computer. Since she does have some residual 
vision, she can use the onscreen pointer for some tasks, and she has used Mouse 
preferences to set the pointer size so it’s large enough for her to see it easily. When she 
does research for her classes, she uses VoiceOver or text-to-speech to hear web pages 
read aloud. 

Shandra’s teacher has set up iCal so that it gives her auditory alarms to remind her of 
upcoming due dates and other events. The teacher records his lectures to the class 
with GarageBand as podcasts and posts the audio files on the class website (made with 
iWeb). Because Shandra knows she can listen to the lecture again at home, she’s able 
to concentrate on the teacher’s presentation, without worrying about taking notes. 
Shandra downloads the lectures to her iPod touch and uses its Multi-Touch technology 
to navigate to them when she’s away from her computer. The teacher also puts all his 
Keynote presentations on the class website, so Shandra can view them at home using 
the Zoom feature. With her assignments under control, Shandra has time to produce 
podcasts after school with her friend Grace. They use GarageBand to create the 
podcasts and publish them to iTunes. The podcasts, which have become very popular 
at school, include reports on school events and commentary on world news, music,  
and interviews with classmates, teachers, and community members. 
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Additional Resources 
For resources specific to applications and features discussed in 
this guide, see the “Learn More” information in those sections. 
This section provides an overview of the collection of resources 
you can use to get more ideas about using Apple technology 
with diverse learners.

Apple Accessibility

www.apple.com/education/special-education

Since 1985, Apple has been committed to helping people with disabilities access their 
personal computers. Find specific hardware and software that meets your students’ needs. 

Apple Resources

Includes guides, lesson plans, tutorials, and more

www.apple.com/education/resources

Find Out How in the Classroom

Apple Education Series of tutorials exploring using the Mac in the classroom

www.apple.com/education/resources

Find Out How—Mac Basics

Video and text tutorials for using the Mac

www.apple.com/findouthow/mac

Apple Professional Development

www.apple.com/education/how-to-buy

Apple Professional Development offers a wide array of workshops to help educators 
effectively infuse technology into the classroom. A two-day workshop can help you 
learn how to apply unique Mac OS X features, applications, and digital tools to enhance 
learning for students with diverse learning needs.

Apple Support

www.apple.com/support

The Apple Support website provides a comprehensive collection of tutorials, product 
manuals, answers to troubleshooting questions, discussion boards, software updates, 
product specifications, tips, and more.

http://www.apple.com/education/special-education
http://www.apple.com/education/resources
http://www.apple.com/education/resources
http://www.apple.com/findouthow/mac
http://www.apple.com/education/how-to-buy
http://www.apple.com/support


Learn more.
To learn more about Apple products and solutions for education,
visit www.apple.com/education.
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